# Contents

## Chapter 1. Pro Tools Menu (Macintosh Only)

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Pro Tools</td>
<td>1</td>
</tr>
<tr>
<td>Preferences</td>
<td>1</td>
</tr>
<tr>
<td>Macintosh Application Management Commands</td>
<td>1</td>
</tr>
<tr>
<td>Quit Pro Tools</td>
<td>1</td>
</tr>
</tbody>
</table>

## Chapter 2. File Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Session</td>
<td>3</td>
</tr>
<tr>
<td>Open Session</td>
<td>4</td>
</tr>
<tr>
<td>Close Session</td>
<td>4</td>
</tr>
<tr>
<td>Save</td>
<td>4</td>
</tr>
<tr>
<td>Save As</td>
<td>4</td>
</tr>
<tr>
<td>Save Copy In</td>
<td>4</td>
</tr>
<tr>
<td>Revert to Saved</td>
<td>5</td>
</tr>
<tr>
<td>Send via DigiDelivery</td>
<td>6</td>
</tr>
<tr>
<td>Bounce to Commands</td>
<td>6</td>
</tr>
<tr>
<td>Import</td>
<td>8</td>
</tr>
<tr>
<td>Export</td>
<td>10</td>
</tr>
<tr>
<td>Get Info</td>
<td>10</td>
</tr>
<tr>
<td>Exit</td>
<td>10</td>
</tr>
</tbody>
</table>

## Chapter 3. Edit Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>11</td>
</tr>
<tr>
<td>Redo</td>
<td>11</td>
</tr>
<tr>
<td>Cut</td>
<td>11</td>
</tr>
<tr>
<td>Copy</td>
<td>11</td>
</tr>
<tr>
<td>Paste</td>
<td>11</td>
</tr>
<tr>
<td>Clear</td>
<td>12</td>
</tr>
<tr>
<td>Cut Special</td>
<td>12</td>
</tr>
</tbody>
</table>
Copy Special ................................................................. 12
Paste Special ............................................................... 12
Clear Special ................................................................. 12
Select All ........................................................................ 13
Selection ......................................................................... 13
Play Edit Selection ......................................................... 13
Duplicate ......................................................................... 13
Repeat ............................................................................. 13
Shift ............................................................................... 13
Insert Silence .................................................................. 13
Trim Region ....................................................................... 13
Separate Region ................................................................ 14
Heal Separation ................................................................ 14
Strip Silence ..................................................................... 15
Consolidate ........................................................................ 15
TCE Edit to Timeline Selection ....................................... 15
Thin Automation ............................................................... 15
Automation ....................................................................... 15
Fades .............................................................................. 17

Chapter 4. View Menu ......................................................... 19
Narrow Mix ...................................................................... 19
Mix Window ...................................................................... 19
Edit Window ..................................................................... 19
Rulers .............................................................................. 20
Region ............................................................................. 20
Sends A–E ........................................................................ 21
Sends F–J ........................................................................ 21
Track Number ................................................................... 21
Transport ........................................................................ 21
System Usage .................................................................... 21
Disk Space ........................................................................ 21
Main Counter .................................................................... 21
Chapter 5. Track Menu

New Track ......................................................... 23
Group ............................................................... 23
Duplicate .......................................................... 24
Split Into Mono .................................................... 24
Make Inactive or Make Active ................................. 24
Delete ............................................................... 24
Write MIDI Real-Time Properties ............................. 24
Avid Video .......................................................... 24
Set Record Tracks to Input Only .............................. 25
Set Record Tracks to Auto Input .............................. 25
Auto Input Monitoring .......................................... 25
Input Only Monitoring .......................................... 25
Scroll To Track .................................................... 26
Clear All Clip Indicators ....................................... 26

Chapter 6. Region Menu ........................................ 27

Mute/Unmute Region ............................................. 27
Lock/Unlock Region .............................................. 27
Send to Back ....................................................... 27
Bring To Front ..................................................... 27
Group ............................................................... 28
Ungroup ............................................................. 28
Ungroup All ........................................................ 28
Regroup ............................................................. 28
Loop ................................................................. 28
Unloop ............................................................... 28
Rename Region ..................................................... 28
Capture Region ..................................................... 28
Identify Sync Point and Remove Sync Point .............. 29
Quantize to Grid ................................................... 29

Chapter 7. Event Menu .......................................... 31

Time ................................................................. 31
Tempo ............................................................... 33
MIDI ................................................................. 34
Chapter 8. AudioSuite Menu ................................................. 41
   EQ Plug-Ins ................................................................. 41
   Dynamics Plug-Ins ....................................................... 42
   Pitch Shift Plug-Ins .................................................... 42
   Reverb Plug-Ins .......................................................... 42
   Delay Plug-Ins ............................................................ 43
   Modulation Plug-Ins ..................................................... 43
   Harmonic Plug-Ins ........................................................ 43
   Noise Reduction Plug-Ins .............................................. 43
   Instrument Plug-Ins ..................................................... 43
   Other Plug-Ins ............................................................ 44

Chapter 9. Options Menu .................................................. 45
   Destructive Record ....................................................... 45
   Loop Record ............................................................... 45
   QuickPunch ................................................................. 45
   TrackPunch ................................................................. 46
   Transport Online ........................................................ 46
   Video/Movie Track Online ............................................. 46
   Movie Track Online ...................................................... 46
   QuickTime DV Out FireWire .......................................... 46
   Pre/Post-Roll ............................................................... 46
   Loop Playback ............................................................. 46
   Scrolling ..................................................................... 47
   Link Timeline and Edit Selection .................................. 47
   Link Track and Edit Selection ....................................... 48
   Mirror MIDI Editing .................................................... 48
Contents

Chapter 10. Setup Menu .................................................. 51
  Hardware ........................................................................ 51
  Playback Engine ............................................................... 52
  Disk Allocation .................................................................. 52
  Peripherals .......................................................................... 52
  I/O .................................................................................. 54
  Machine Track Arming Profiles ........................................... 54
  QuickTime Movie Offset .................................................... 54
  Session .............................................................................. 55
  Current Feet+Frames Position ............................................ 55
  Current Time Code Position ............................................... 55
  External Time Code Offset .................................................. 55
  MIDI .................................................................................. 56
  Click ................................................................................ 57
  Preferences ........................................................................ 58

Chapter 11. Window Menu .................................................. 71
  Mix .................................................................................. 71
  Edit .................................................................................. 71
  Task Manager ...................................................................... 71
  Workspace .......................................................................... 71
  Project ............................................................................. 72
  Browsers ........................................................................... 72
  Transport ........................................................................... 72
  Big Counter ......................................................................... 72
Chapter 1

Pro Tools Menu (Macintosh Only)

Pro Tools Menu
(Macintosh Only)

The Pro Tools Menu commands include links to Pro Tools Preferences, access to Mac OS X application management, and the Quit command.

Macintosh Application Management Commands
(Services, Hide Pro Tools, Hide Others, Show All)

The Pro Tools menu also provides access to the following Macintosh OS X application management commands: Services, Hide Pro Tools, Hide Others, and Show All. For more information about these and other Mac OS X features, refer to your Apple Macintosh documentation.

Quit Pro Tools

The Quit Pro Tools command ends your Pro Tools session and closes the Pro Tools application.

About Pro Tools

The About Pro Tools command launches the Pro Tools banner, which includes the version number of your Pro Tools software.

Preferences

Pro Tools Preferences are available from both the Pro Tools Menu and the Setup menu. For more information, see “Preferences” on page 58.
File Menu

File menu commands are used to create and maintain Pro Tools sessions.

New Session

The New Session command creates a new Pro Tools session. Before the session is created, you must name the session and choose its Audio File type, Sample Rate, Bit Depth, and I/O Settings in the New Session dialog.
Open Session

The Open command opens a session previously created with Pro Tools. Only one session can be open at a time.

Close Session

The Close command closes the current session without quitting Pro Tools. Pro Tools prompts you to save changes before closing the session.

Save

The Save command saves changes made since the last time the session was saved. You cannot undo the Save command.

Save As

The Save As command lets you save a copy of the current session under a different name, or in a different location. Because the Save As command closes the current session and allows you to keep working on the renamed copy, it is useful for saving successive stages of the session.

Save Copy In

The Save Copy In command lets you save a copy of the currently selected session under a different name or in a different location. Session media can be included in the copy that you save, with options to save the media at a different bit depth, sample rate, fader gain level, or file format type. Sessions can be saved in a variety of session formats for compatibility with older systems. This command is useful for archiving sessions.

Unlike the Save As command, Save Copy In does not close the original session, so subsequent edits are made to the original session. The saved copy becomes a backup copy, and gives you the option of returning to the earlier version.
When you Save Copy In with a lower bit rate, Pro Tools Dither with Noise Shaping will be applied. The Dither setting used for any conversion is the Digidesign Dither plug-in with Noise Shaping enabled.

For information on sharing sessions between different platforms, Pro Tools systems, or Pro Tools software versions, see the Pro Tools Reference Guide.

The Items To Copy section of this dialog provides several options for copying a session along with its associated files.

**All Audio Files** When selected, all audio files are copied to the new location. Selecting All Non-“file type” Audio Files copies all audio files except audio files of the specified audio file type. This option’s file type will always be the default audio file type of the session; so if the session’s default audio file type is WAV, the option will read All Non-WAV Audio Files. Selecting Don’t Copy Fade Files omits fade files from the copied data.

**Session Plug-In Settings Folder** When selected, the session’s Plug-In Settings Folder is copied to the new location. The references to these plug-in settings in the session are redirected to the copied files.

**Root Plug-In Settings Folder** When selected, the contents of the root-level Plug-In Settings Folder are copied into a folder named Place in Root Settings Folder, indicating that these files will need to be moved to the root level plug-in settings folder on the destination system before you can use them. The references to these settings files in the session are not redirected to point to the copied files.

**Movie/Video Files** When selected, the session’s video files are copied to the new location, and the references in the session are redirected to the copied movie or video file.

**Revert to Saved**

The Revert to Saved command restores the most recently saved version of a session, discarding all changes made since the last time you saved. Reverting to the last saved version of a session is like closing the session without saving changes and reopening it.
Send via DigiDelivery

DigiDelivery is Digidesign’s system for efficient and reliable transfer of digital media files over the Internet. Send via DigiDelivery lets you send a Pro Tools session and all of its related files using DigiDelivery from within Pro Tools.

Anyone can send and receive files from a DigiDelivery system, even if they do not own a DigiDelivery network appliance, as follows:

- To send a delivery, senders must have an Internet connection, an account on a DigiDelivery network appliance, and the DigiDelivery client application.
- To receive a delivery, recipients only need an Internet connection and the DigiDelivery client application. An account on the network appliance is not needed.

For more information about DigiDelivery, see the DigiDelivery Guide.

Bounce to Commands

The Bounce to commands let you mix tracks together into one file.

Bounce to Disk

The Bounce to Disk command allows you to mix together the outputs of all currently audible tracks routed to a common output path to create a new audio file. You can use the Bounce to Disk command to create a submix or to create a final mix in any of several audio file formats.

Bounce to Disk dialog

**Bounce Source** Selects the audio output path to bounce. Only audio routed to the selected path will be included in the bounce.

**Enforce Avid Compatibility** Creates frame-accurate edits, wraps the files as OMFI (unless File Type is MXF), and limits the sample rate options to 44.1 kHz or 48 kHz. Dithering without noise shaping will be applied to files being exported from 24-bit to 16-bit.
File Type
Selects the audio file type. Choices on all systems are BWF (.WAV), AIFF, MPEG-1 Layer 3 (MP3), and QuickTime. Windows systems also include Windows Media (Windows). Macintosh systems also include SD II and Sound Resource. Systems with the DigiTranslator option also support MXF audio files.

Certain file types are restricted in regards to format, resolution, and sample rate.

Format
Selects the channel format (number of channels). Choices are mono (summed), multiple mono, or interleaved.

Resolution
Selects the bit depth. Choices are 24-bit, 16-bit, or 8-bit resolution.

Sample Rate
Selects the sample rate.

Whenever a Bounce to Disk is configured to a different file type, file format, resolution, or sample rate, additional options become available to convert during or after the bounce. See “Additional Bounce Options” on page 7 for more information.

Import After Bounce
Automatically imports the audio after it is bounced and adds it to the Region List so that it can be used in the session.

The Import After Bounce option is only available if the target file type and sample rate for the bounce are the same as the file type and sample rate of the current session, and the target resolution (bit rate) is the same or lower than the resolution of the session. In addition, tracks bounced to a Stereo Interleaved file cannot be imported after a bounce.

Additional Bounce Options
The following Bounce options are only available when bouncing to a different file type, format, resolution, or sample rate.

Conversion Quality
Selects the quality, with option ranging from Low to Tweak Head, when bouncing to a new sample rate.

Use Squeezer
Optimizes the dynamics of the bounced audio before conversion to 8-bit resolution.

Convert During Bounce
Automatically performs file type, sample rate, and bit resolution conversion as the file is being bounced.

Convert After Bounce
Automatically performs file type, sample rate, and bit resolution conversion after the file has been bounced.

Bounce to QuickTime Movie
This command compiles a new QuickTime movie with the current session as the audio soundtrack. Pro Tools will convert the audio tracks to the selected sample rate and bit resolution, then create a new flattened movie with the bounced audio. As a QuickTime file, the new movie is supported by all software applications that support QuickTime video.
Pro Tools provides several menu commands to import files and regions into an open session.

**Import Session Data**

This command lets you import selected session data from an existing session into the current session. Options are provided for time code mapping, track offset options, sample rate conversion, and copying, converting, and referencing audio and video source files. The Import Session Data command also lets you import the Tempo Meter Map and any Markers/Memory Locations.

With Pro Tools HD, you can select specific session data (such as automation and routing) to import. You can also import main playlist options—either replacing existing options or overlaying elements onto existing tracks.

![Import Session Data dialog](image)  
*Figure 1. Import Session Data dialog*
Import Region Groups

This command loads region groups into the Region List without creating a new track.

Import Audio to Track

This command loads audio files or regions into the current session. Each imported audio file will appear on its own individual track.

Import Audio to Region List

This command lets you import audio into the Region List without automatically creating new tracks.

Import Audio from Current Movie

This command imports audio directly from a QuickTime movie currently loaded into a session. Pro Tools will convert the audio to the current session sample rate and bit resolution.

Import Audio from QuickTime Movie

This command imports audio from a QuickTime movie on your hard drive. If necessary, Pro Tools will convert the audio to the current session sample rate and bit resolution. This command can also be used to import audio files from audio CDs.

Import MIDI to Track

The Import MIDI to Track command imports all tracks from a Standard MIDI file into Pro Tools and automatically places them in new MIDI tracks.

Options are provided for importing the Session Start or Song Start Marker (if the marker is not located at the session start), importing tempo map data contained in the sequence, and removing existing Instrument or MIDI tracks.

Import MIDI to Region List

This command imports all tracks from a Standard MIDI file into Pro Tools without automatically creating new tracks for them. Imported tracks appear in the Region List and can then be dragged into a MIDI track.

Options are provided for importing the Session Start or Song Start Marker (if the marker is not located at the session start), importing tempo map data contained in the sequence, and removing existing Instrument or MIDI tracks.

Import QuickTime Movie

(Pro Tools Systems without an Avid DNA Video Peripheral Only)

This command imports a QuickTime movie into the current session. Once imported, the QuickTime movie is displayed in its own Movie track in the Edit window, and in a floating Movie window. With a QuickTime movie in a session, Pro Tools serves as a fast, random-access visual reference for “sweetening” the movie by adding sound effects, music, Foley, dialog, or other audio.

Import Avid Movie or QuickTime Movie

(Pro Tools HD with an Avid DNA Video Peripheral Only)

This command imports a QuickTime movie (or Avid Video) into the current session. Once imported, the QuickTime movie (or Avid Video) is displayed in its own Movie track in the Edit window, and in a floating Movie window. With a QuickTime movie (or Avid Video) in a session, Pro Tools serves as a fast, random-access visual reference for “sweetening” the movie by adding sound effects, music, Foley, dialog, or other audio.
**Export**

Pro Tools provides several menu commands to export session tracks or data as files.

**Export Selected Tracks as OMF/AAF (DigiTranslator Option Only)**

The Export Selected Tracks as OMF command exports selected tracks in AAF and OMFI format. Advanced Authoring Format (AAF) and Open Media Framework Interchange (OMFI) are industry standard file formats that facilitate the transfer of digital media between applications (such as Pro Tools and Avid Video editing software). If the DigiTranslator option is not installed, the Export Selected Track as OMF command will be greyed out in the File menu.

*For more information, see the DigiTranslator 2.0 Integrated Option Guide.*

**Export MIDI**

This command exports all currently audible MIDI tracks in a session as a standard MIDI file. Muted MIDI tracks will not be exported. You can export the file as a Type 1 (multitrack) or Type 0 (merged) Standard MIDI file.

**Export Session Info as Text (Pro Tools HD Only)**

This command exports the current session as a tab-delimited text file that can contain region and file names, extended timestamp information, and information about crossfades.

You can export to any of several different text file formats (including Microsoft Word and Excel).

![Export Session Info as Text dialog](dialog.png)

**Get Info**

This command lets you enter and save information about the session.

Left-column text fields are topic fields. Text entered there is saved with your Pro Tools Preferences and will appear in all sessions, allowing you to preset the field to topics that you commonly use.

Right-column text fields are information fields and are session specific and will be saved with the session.

**Exit (Windows Only)**

The Exit command ends your Pro Tools session and closes the Pro Tools application.
Edit Menu

Edit menu commands are used to edit and manipulate the current selection and affect data in the timeline.

<table>
<thead>
<tr>
<th>Edit</th>
<th>View</th>
<th>Track</th>
<th>Region</th>
<th>Event</th>
<th>Auto</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo At Selection</td>
<td>McKZ</td>
<td>Can’t Redo</td>
<td>McKZ</td>
<td>Cut</td>
<td>McKX</td>
</tr>
<tr>
<td>Copy</td>
<td>McKC</td>
<td>Paste</td>
<td>McKV</td>
<td>Clear</td>
<td>McKB</td>
</tr>
<tr>
<td>Cut Special</td>
<td></td>
<td>Paste Special</td>
<td></td>
<td>Clear Special</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>McKA</td>
<td>Selection</td>
<td></td>
<td>Duplicate</td>
<td>McKD</td>
</tr>
<tr>
<td>Repeat…</td>
<td>McKR</td>
<td>Shift…</td>
<td>McKH</td>
<td>Insert Silence</td>
<td>McKE</td>
</tr>
<tr>
<td>Trim Region</td>
<td></td>
<td>Separate Region</td>
<td></td>
<td>Heal Separation</td>
<td>McKH</td>
</tr>
<tr>
<td>Heal Region</td>
<td></td>
<td>Strip Silence</td>
<td>McKU</td>
<td>Consolidate</td>
<td>McKB</td>
</tr>
<tr>
<td>TCE Edit to Timeline Selection</td>
<td>MKOU</td>
<td>Automation</td>
<td></td>
<td>Fades</td>
<td></td>
</tr>
</tbody>
</table>
Clear

This command removes the contents within a selection in the Edit window.

Cut Special

The Cut Special commands let you cut just automation data from the current selection (without associated audio or MIDI notes) and place it in memory to paste elsewhere. Choices include:

All Automation Cuts all automation or MIDI controller data whether it is shown or not.
Pan Automation Cuts only pan automation or MIDI pan data whether it is shown or not.
Plug-In Automation Cuts only plug-in automation that is shown.

Copy Special

The Copy Special commands let you copy just automation data from the current selection (without associated audio or MIDI notes) and place a copy of it in memory to paste elsewhere.

All Automation Copies all automation or MIDI controller data whether it is shown or not.
Pan Automation Copies only pan automation or MIDI pan data whether it is shown or not.
Plug-In Automation Copies only plug-in automation that is shown.

Paste Special

The Paste Special commands let you paste automation data into another region (without affecting associated audio or MIDI notes) in the following ways:

Merge Pastes MIDI controller data from the clipboard to the selection and merges it with any current MIDI controller data in the selection. This can be useful for consolidating MIDI data from several tracks into a single MIDI track.
Repeat to Fill Selection Pastes multiple iterations of audio or MIDI data from the Clipboard to fill the selection. If you select an area that is not an exact multiple of the copied region size, the remaining selection area is filled with a trimmed version of the original selection. This allows you to easily create drum loops and other repetitive effects. Before the data is pasted, Pro Tools prompts you to specify a crossfade to smooth transitions between regions.
To Current Automation Type Pastes the automation or MIDI controller data from the clipboard to the selection as the current type of automation or continuous MIDI data. This lets you copy one type of automation data to another, or one type of continuous MIDI date to another type of contiguous MIDI data.

Clear Special

The Clear Special commands let you clear just automation data from the current region. Choices in the Clear Special submenu are All Automation, Pan Automation, and Plug-In Automation.
Select All
This command selects all audio and MIDI data in one or more tracks.
- To select all regions in a single track, select a portion of the track, or click the Selector anywhere in a track and choose Select All.
- To select all regions on multiple tracks, Shift-click a region on each track with the Selector or Grabber and choose Select All.
- To select all regions on all tracks, Select the “All” Edit Group in the Groups List, click the Selector anywhere in a track, and choose Select All.

Selection
(Pro Tools HD Only)
The Selection commands are for copying or playing Edit or Timeline selections.

Change Timeline to Match Edit
When the Edit and Timeline selections are unlinked, this command copies the current Timeline selection to the an Edit selection.

Change Edit to Match Timeline
When the Edit and Timeline selections are unlinked, this command copies the current Edit selection to the Timeline.

Play Edit
(Pro Tools HD Only)
This command plays an Edit selection.

Play Timeline
(Pro Tools HD Only)
This command plays a Timeline selection.

Play Edit Selection
(Pro Tools LE and M-Powered Only)
This command plays an Edit selection.

Duplicate
This command copies a selection and places it immediately after the end of that selection in a track.

Repeat
This command is similar to Duplicate, but allows you to specify the number of times the selected material is duplicated. To use this command, select the material you want to repeat, choose Repeat, then enter the number of repetitions.

Shift
This command moves track material earlier or later in time by a specified amount. To use this command, select the material you want to move, choose Shift, then enter the desired direction and time value.

Insert Silence
This command creates regions of silence. Make a selection on one or more tracks, choose Insert Silence, and precisely that amount of silence will be inserted.

Trim Region
This command provides several options for editing region boundaries (including looped regions).
To Selection
This command removes data before and after a region or MIDI note selection, leaving only the selection. This command lets you quickly remove all data in a region (and in some instances the entire track) except for the current selection.

Start to Insertion
This command lets you trim a region or MIDI note by automatically removing the material between the Edit insertion point and the start point.

End to Insertion
This command lets you trim a region or MIDI note by automatically removing the material between the Edit insertion point and the end point.

Start to Fill Selection
This command lets you automatically reveal underlying material in the gaps between the region start and selection start points.

End to Fill Selection
This command lets you automatically reveal underlying material in the gaps between the selection end and region end points.

To Fill Selection
This command lets you automatically reveal underlying material in the gaps before and after the selection.

Separate Region
These commands separate a region from adjacent data in the track where it was created. By separating a region you will also create by-product regions from data on either side of the separation.

The Separate Region commands automatically unloop and flatten looped regions before separating.

At Selection
This command creates new region boundaries at the selection start and end points.

On Grid
This command constrains newly created regions to start and end on grid points.

At Transients
This command automatically creates region boundaries on detected transients within a selection.

Heal Separation
This command repairs separated regions, provided that the regions are contiguous and their relative start and end points haven’t changed since they were originally separated. If you have trimmed or changed the start and end points of the two regions, or moved them away from each other, they cannot be repaired with the Heal Separation command.
**Strip Silence**

This command opens the Strip Silence window. Use this window to remove areas of silence from a selection. Strip Silence automatically divides a selection into regions, which can be useful for quantizing audio to musical values or SMPTE locations.

**Consolidate**

This command consolidates multiple regions into a single region. When an audio track is consolidated, a new audio file is written that encompasses the selection range, including any blank space or fades.

**TCE Edit to Timeline Selection**  
*(Pro Tools HD Only)*

This command uses the Time Compression/Expansion plug-in to fit an audio selection to a Timeline selection. This is only possible when the Edit and Timeline selections are unlinked.

**Thin Automation**  
*(Pro Tools LE and M-Powered Only)*

This command lets you selectively thin areas in a track where automation data is too dense and adversely affecting CPU performance. The amount of thinning performed is determined by the amount you have selected in the Automation page of the Preferences dialog. Avoid over-thinning data or it may no longer accurately reflect the original automation.

**Automation**  
*(Pro Tools HD Only)*

With Pro Tools HD, multiple Automation commands are available.

**Copy to Send**

This command lets you copy either the current values or automation of a selected track’s volume, pan, mute, or LFE automation to the corresponding playlist for the send. This is useful when you want a track’s send automation to mirror automation on the track itself.

To copy a track’s current control settings to a send on that track, select Current Value. To copy the entire automation playlist for the track to a send, select Automation.
Thin Automation
This command lets you selectively thin areas in a track where automation data is too dense and adversely affecting CPU performance. The amount of thinning performed is determined by the amount you have selected in the Automation page of the Preferences dialog. Avoid over-thinning data or it may no longer accurately reflect the original automation.

Write to Current and Write to All Enabled
These commands let you write automation states for one or more parameters to specific session locations in a single step. This saves you the trouble of performing multiple automation passes for different parameters in real time, or having to graphically draw automation state changes on individual automation playlists.

Write to Current Parameters
This command writes the current value only to the currently displayed automation parameter.

Write to All Enabled Parameters
This command writes the current settings for all automation parameters enabled in the Automation Enable window.

Trim to Current and Trim to All Enabled
These commands let you use trim values as snapshots and apply the relative changes or delta values to the selected automation. This is similar to the Write Automation command, except that it writes delta values instead of absolute values to automation data. You can use trim values in writing snapshot automation to any automatable parameter.

Trim to Current Parameter
This command trims the current value only to the currently displayed automation parameter.

Trim to All Enabled Parameters
This command trims the current settings for all automation parameters enabled in the Automation Enable window.

Glide to Current and Glide to All Enabled
These commands let you manually create an automation transition (or glide) from an existing automation value to a new one, over a selected area.

Glide to Current Parameter
This command applies Glide Automation only to the currently displayed automation parameter.

Glide to All Enabled Parameters
This command applies the Glide Automation for all automation parameters enabled in the Automation Enable window.
**Fades**

These commands let you create (or delete) a crossfade between two adjacent audio regions, or a fade-in or fade-out of a single region. Crossfade duration, position, and shape are all selectable. A selection that crosses multiple regions will create crossfades for each of the region transitions. If a selection includes regions that already contain crossfades, the existing crossfades will be modified.

**Create**

The Create command produces a crossfade between adjacent regions according to parameters you specify with the Fades editor.

**Delete**

The Delete command removes a crossfade between adjacent regions.

**Fade to Start**

The Fade to Start command creates a fade-in from the current insertion point to a region’s start point.

**Fade to End**

The Fade to End command creates a fade-out from the current insertion point to a region’s end point.
View Menu

View menu options and commands control the display of Pro Tools windows, tracks, and track data. Some View menu options toggle the display of various Pro Tools windows or data: selecting the option displays the data, and deselecting the option hides the data.

- **Narrow Mix**
  This option reduces the width of Mix channels on-screen, allowing you to display the maximum number of tracks on your computer monitor. In this view, track names, names of sends, and plug-in names are abbreviated to accommodate the smaller view. To return to normal view width, choose this command again.

- **Mix Window**
  These options selectively display Mic Preamps (Pro Tools HD only), Instruments, Inserts, Sends A–E, Sends F–J, Delay Compensation (Pro Tools HD only), Track Color, and Comments views in the Mix window. You can also select All of the displays, or None of them.

- **Edit Window**
  These options selectively display Comments, Mic Preamps (Pro Tools HD only), Instruments, Inserts, Sends A–E, Sends F–J, I/O, Real-Time Properties, Track Color, and Transport views in the Edit window. You can also select All of the displays, or None of them.
Rulers

These options selectively display various Timebase and Conductor rulers in the Edit window. In addition to providing a timing reference for track material, Timebase rulers are used to define Edit and Timeline selections.

Besides selecting individual rulers, you can select All of the rulers, or None of them.

Timebase Rulers

Any or all of the following Timebase rulers can be displayed at the top of the Edit window:

- Bars:Beats
- Minutes:Seconds
- Time Code (Pro Tools HD and Pro Tools LE with DV Toolkit only)
- Feet+Frames (Pro Tools HD and Pro Tools LE with DV Toolkit only)
- Samples

In addition to providing a timing reference for track material, the Timebase rulers are also used to define Edit selections for track material, and Timeline selections for record and play ranges.

Conductor Rulers

Any or all of the following Conductor rulers can be displayed:

- Markers
- Tempo (and Tempo Editor)
- Meter

The Meter and Tempo rulers indicate changes in meter and tempo within the Session. The Markers ruler displays Markers to important track locations.

The Tempo Editor is an expansion of the Tempo ruler, opening in the rulers section of the Edit window.

Region

Sync Point

This option lets you display or hide sync points in regions. Regions will align to a sync point regardless of its display status.

Name

This option lets you display or hide a region’s name in tracks in the Edit window. Hiding a display is useful if you are working at a zoom level where region names obscure the view of audio waveforms.

Overlap

This option lets you display or hide the region overlap “dog-ear” corner that indicates overlapping region boundaries.

Current Time

This option displays the time stamp of all regions placed in all tracks according to their current location in the track.

With the Selector, drag in any Timebase ruler to select material across all tracks in the Edit window. To include the Conductor Tracks in the selection, press Alt (Windows) or Option (Macintosh) while dragging.
**Original Time Stamp**

This option displays the Original Time Stamp of all regions in all tracks. When a region is created, it is time stamped relative to the SMPTE start time specified for the session. This original time stamp is permanently stored with the region and cannot be changed. If a region is ever moved, it can easily be placed at its original position using the Spot dialog.

**User Time Stamp**

This option displays the User Time Stamp of all regions in all tracks. When a file is first recorded, its User Time Stamp is identical to its original time stamp. You can change the User Time Stamp using the Time Stamp Selected command in the Region List. This allows you to use a custom time stamp for spotting or re-spotting the region to a time location different from its Original Time Stamp.

**No Time**

This option disables the time stamp display in regions.

**Sends A–E**

These options display either send assignments for all sends, or the controls for individual sends (Sends A–E). Select Assignment to display all five of these send assignments.

**Sends F–J**

These options display either send assignments for all sends, or the controls for individual sends (Sends F–J). Select Assignment to display all five of these send assignments.

**Track Number**

This command assigns each track a number corresponding to its position in the Mix and Edit windows. When tracks are reordered, track numbers stay in positional sequence.

**Transport**

These options selectively display Counters, MIDI Controls, and Expanded controls in the Transport window.

**System Usage**

(Pro Tools HD Only)

These options set the display format for the System Usage window: Small, Large, Detailed, Gas Gauge, or Activity Only. The System Usage window shows the usage of DSP and CPU resources during a session.

**Disk Space**

These options specify either a Text or Gas Gauge style display format for the Disk Space window. The Disk Space window shows how much recording time is currently available on each hard drive connected to your system.

**Main Counter**

These view options set how the Time Scale is displayed in the Main Counter.

**Bars:Beats**

This option displays the Time Scale in Bars and Beats. Use this Time Scale if you are working with musical material that must align with bars and beats.
**Minutes:Seconds**

This option displays the Time Scale in minutes and seconds.

**Time Code**

*(Pro Tools HD and Pro Tools LE with DV Toolkit Only)*

This option displays the Time Scale in SMPTE frames. The Frame Rate and Session Start time are set from the Session Setup window.

Pro Tools supports the following frame rates: 24, 25, 29.97 Non-Drop, 29.97 Drop, 30 Non-Drop, and 30 Drop frames per second.

**Feet+Frames**

*(Pro Tools HD and Pro Tools LE with DV Toolkit Only)*

This option displays the Time Scale in feet and frames for referencing audio-for-film projects. The Feet+Frames time display is based on the 35 millimeter film format.

**Samples**

This option displays the Time Scale in samples. This format is useful for high-resolution sample editing.
Track Menu

Track menu commands are used to create, manage, and edit tracks.

Audio tracks, Auxiliary Inputs, and Master faders can be mono or stereo, or a greater-than-stereo multichannel format (Pro Tools HD only).

New Track

The New Track command lets you add one or more new audio tracks, Auxiliary Inputs, MIDI tracks, Master Faders, or Instrument tracks to a session.

Group

This command groups the currently selected tracks together so that their controls are linked together in either or both the Mix and the Edit window. Groups can be nested so that subgroups are contained within larger groups.
**Duplicate**

This command lets you define how many copies of a track you want to create, and specifies whether to copy audio or MIDI data, playlists, automation, and other attributes.

When duplicating multiple tracks, you can also choose to have the new tracks follow the last selected track (or have each new track follow its source track).

**Split Into Mono**

This command splits a selected stereo or multichannel track into individual mono tracks that can be edited and manipulated independently. The Split Into Mono command cannot be undone.

**Make Inactive or Make Active**

This command makes selected tracks inactive, so that they no longer play back or use any DSP resources or voices. Inactive tracks can be made active again by choosing the Make Active command.

**Delete**

This command removes tracks from a session. While audio or MIDI region data will remain in the Region List, the track and its arrangement of the regions on the deleted track (the track’s playlist) will be lost.

If the track contains playlists that are not assigned to any track, you will be prompted to delete or retain them.

**Write MIDI Real-Time Properties**

This command applies MIDI quantization, duration, delay, velocity, and transposition parameters during playback, as set in Real-Time Properties View (in the Edit window) or in the MIDI Real-Time Properties dialog.

**Avid Video**

*(Pro Tools HD with Avid DNA Video Peripherals Only)*

Avid Video commands are used for adding video tracks and other audio formats to a session, and managing movie playback.

**New Track**

This command creates a new empty movie track into which you can record or import Avid video.

**Add Video**

This command adds additional movie clips to the Video track. You will be prompted to spot the clip to a SMPTE location. If the clip is spotted to a location that already contains a movie clip, the first clip will be truncated.

**Undo Add Video**

This command undoes the Add Video command and other Movie track editing functions such as moving, copying, or clearing clips. These actions cannot be undone by choosing the standard Undo command from the Edit menu.
Clear Selection
This command clears a selection in the Video track. This allows simple editing of movie clip content.

Clear Track
This command clears the entire Video track.

Set Scrub Window Size & Location
This command lets you store the current size and location of the Pro Tools Movie window.

Use Scrub Window
This command opens a Scrub window, which displays the Avid video at quarter-resolution, but accurately scrubs the video. When the Scrub window is open, video output alternates automatically between the Scrub window and the video reference monitor depending on whether or not you are scrubbing.

When scrubbing, the video reference monitor is black. When leaving Scrub mode, the Scrub window disappears and video is routed to the video reference monitor.

⚠️ The Scrub window is only available in Pro Tools systems with a Digidesign-qualified Avid DNA video peripheral (such as AVoption|V10 or Mojo), and when there is Avid video in the Movie track. There is no Scrub window for QuickTime video.

Set Record Tracks to Input Only
(Pro Tools HD Only)
This command changes all record enabled tracks to monitor audio input only, regardless of any punch in or out selection.

Set Record Tracks to Auto Input
(Pro Tools HD Only)
This command changes all record enabled tracks to automatically switch from monitoring input signals to monitoring recorded tracks. When set, record enabled tracks monitor audio input when the transport is stopped. When playback is started for a punch-in, Pro Tools monitors existing track material up until the punch point. While punched in, the input signal is monitored. On punch-out, monitoring switches back to the existing track material. This is similar to the auto-switching logic found on digital and analog multitrack tape machines.

Auto Input Monitoring
(Pro Tools LE and M-Powered Only)
In this mode, when session playback is stopped, Pro Tools monitors audio input. When playback is started for a punch-in, Pro Tools monitors existing track material up until the punch point. While punched in, the input signal is monitored. On punch-out, monitoring switches back to the existing track material. This is similar to the auto-switching logic found on digital and analog multitrack tape machines.

Input Only Monitoring
(Pro Tools LE and M-Powered Only)
In this mode, when a track is record-enabled, Pro Tools monitors audio input only, regardless of any punch in or out selection.
Scroll To Track

This command lets you scroll directly to any track by position number. The Edit window tracks will scroll to bring the selected track to as close to the top as possible, and the Mix window tracks will scroll to bring the selected track as close to the left as possible.

Clear All Clip Indicators

This command clears all clip indication from all meters.
Region Menu commands are used to manage and edit regions.

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute/Unmute</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Lock/Unlock</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Send to Back</td>
<td>Alt+Shift+B</td>
</tr>
<tr>
<td>Bring to Front</td>
<td>Alt+Shift+F</td>
</tr>
<tr>
<td>Group</td>
<td>Ctrl+Alt+G</td>
</tr>
<tr>
<td>Ungroup</td>
<td>Ctrl+Alt+U</td>
</tr>
<tr>
<td>Ungroup All</td>
<td></td>
</tr>
<tr>
<td>Regroup</td>
<td>Ctrl+Alt+R</td>
</tr>
<tr>
<td>Loop...</td>
<td>Ctrl+Alt+L</td>
</tr>
<tr>
<td>Unloop...</td>
<td></td>
</tr>
<tr>
<td>Capture...</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Remove Sync Point</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Quantize to Grid</td>
<td>Ctrl+D</td>
</tr>
</tbody>
</table>

**Mute/Unmute Region**

This command mutes playback of a selected region. Choosing the Unmute command unmutes the region. This command does not create automation data.

**Lock/Unlock Region**

This command locks a selected region in place so it cannot be moved unless you unlock it. This command is useful for permanently associating a region with a particular location in a track (such as a beat, SMPTE frame, or time value). A small lock icon appears in the region indicating it has been locked.

**Send to Back**

This command sends the selected region or regions behind any neighboring overlapping regions. If multiple overlapping regions are selected, Pro Tools will apply the command to each region as that region relates to the neighboring region on the right.

**Bring To Front**

This command brings the selected region or regions to the front of any neighboring overlapping regions. If multiple overlapping regions are selected, Pro Tools will apply the command to each region as that region relates to the neighboring region on the right.
Group

The Group command creates a region group from all elements in the current selection. Selections can include audio and MIDI regions on one or more tracks. Multiple region groups can be selected and included in new region groups.

Ungroup

The Ungroup command unpacks the currently selected region group, revealing all underlying regions and any nested region groups. When there are multiple nested region groups, the Ungroup command will ungroup the front-most top-layer region group only, preserving any underlying region groups.

You can also use the Region > Ungroup command on looped regions to unloop and maintain all loop iterations as individual regions.

Ungroup All

The Ungroup All command removes all layers of region groups and nested region groups in the currently selected region in one step.

You can also use the Region > Ungroup All command on looped regions to flatten the looped regions into one region.

Regroup

The Regroup command undoes the last Ungroup command and regroups the individual regions back to their former region group state. This lets you ungroup a grouped region, edit its underlying regions in any way desired, and regroup it to continue working on higher-level composition and arranging.

Loop

The Loop command lets you loop audio and MIDI regions.

Unloop

The Unloop command lets you switch looped regions back to standard (unlooped) regions so that they can be edited individually.

Rename Region

This command lets you rename selected regions. When you rename a whole-file audio region, you can specify whether to rename just the region, or both the region and the disk file.

Capture Region

This command defines a selection as a new region and adds it to the Region List. From there the new region can be dragged into a track. You cannot capture selections across multiple regions unless the data is contiguous material from the same file.
**Identify Sync Point and Remove Sync Point**

This command places a Sync Point at the current cursor location. When you identify a sync point, a small down arrow appears at the bottom of the region, with a vertical, light grey line indicating the location of the sync point. This Sync Point can then be used as the reference point—nudge, spot, move, and so on—instead of the region start or end. With Pro Tools HD, when you choose this command, the current SMPTE time is automatically entered as the SMPTE location for the Sync Point.

To remove a Sync point from a region, select the region with the Grabber and choose Region > Remove Sync Point.

**Quantize to Grid**

This command adjusts the placement of a selected audio or MIDI region in a track so that its start point (or Sync Point, if it contains one) precisely aligns to the nearest Grid boundary. Grid units are chosen from the Grid pop-up menu in the Edit window.
Event Menu

The Event menu contains commands for editing audio and MIDI events.

Time

Pro Tools provides several commands for defining meter and time over a range of time (or measures). The Time options include:

Operations Window

This command opens the Time Operations window. This floating window lets you define meter, click, and song start options by choosing any of the following commands from the pop-up menu at the top of the window:

- Change Meter
- Insert Time
- Cut Time
- Move Song Start

![Time Operations window, Change Meter option](image)
Change Meter

The Change Meter command lets you specify complex meter changes for Bar|Beat-based material. You can enter meter changes at a particular bar, make a meter change over a selected area of time, or add meter changes sequentially one bar at a time.

Cut Time

The Cut Time command lets you cut a specified amount of time from conductor rulers, MIDI tracks, and audio tracks.

Insert Time

The Insert Time command lets you insert an amount of blank time into conductor rulers, MIDI tracks, and audio tracks.

Move Song Start

The Move Song Start command lets you redefine the location of the Song Start Marker.
**Tempo**

Pro Tools provides several commands for defining tempo events over a range of time (or measures). The Tempo commands include:

**Operations Window**

This command opens the Tempo Operations window. This window lets you define tempo events over a range of time (or measures) by choosing any of the following commands from the pop-up menu at the top of the window:

- Constant
- Linear
- Parabolic
- S-Curve
- Scale
- Stretch

**Constant**

This command lets you create a constant tempo over a selected range of time.

**Linear**

This command lets you create tempos that change evenly over a selected range of time.

**Parabolic**

This command lets you create tempos that accelerate or decelerate following a tempo curve, which changes the tempo more rapidly or less rapidly over the selection time.

**S-Curve**

This command lets you create tempos that accelerate or decelerate following a tempo curve with a definable breakpoint that determines mid-curve times and tempo values.

**Scale**

This command lets you scale tempos within the selection by a percentage amount.

**Stretch**

This command lets you select a region of tempo events and apply them to a larger or smaller selection area.
MIDI

Pro Tools provides several commands for changing MIDI data over a range of time (or measures). The MIDI commands include:

Operations Window

This command opens the MIDI Operations window. This floating window lets you configure specific MIDI data by choosing any of the following commands from the pop-up menu at the top of the window:

- Grid/Groove Quantize
- Restore Performance
- Flatten Performance
- Change Velocity
- Change Duration
- Transpose
- Select/Split Notes
- Input Quantize
- Step Input

Grid/Groove Quantize

This command lets you adjust the placement of selected MIDI events in a track using Grid or Groove Quantize.

Grid Quantize lets you adjust the placement of selected MIDI events in a track so that their start or end points precisely align to the quantization value chosen.

Groove Quantize lets you adjust the placement of selected MIDI events in a track so that their timings, durations, and velocities align to the selected groove template grid. Pro Tools installs several pre-defined groove templates for use on all Pro Tools systems. With Pro Tools HD, DigiGroove templates can be created using Beat Detective.
**Restore Performance**

This command lets you restore the original MIDI performance regardless of how many edits you’ve made or whether or not the undo queue has been cleared (for example, by saving the session). One or more of the following note attributes can be restored: Timing (Quantization), Duration, Velocity, and Pitch.

![MIDI Operations window, Restore Performance page](image1)

**Flatten Performance**

This command lets you lock the specified current note parameters as the “restore to” state, overriding the original performance. One or more of the following note attributes can be flattened: Timing (Quantization), Duration, Velocity, and Pitch. Flatten Performance can be undone.

![MIDI Operations window, Flatten Performance page](image2)

**Change Velocity**

This command lets you adjust attack and release velocities for selected MIDI notes. Use it to make notes louder or softer, or to create a crescendo or diminuendo.

![MIDI Operations window, Change Velocity page](image3)
**Change Duration**

This command lets you adjust the duration for selected MIDI notes. It can be used to make melodies and phrases more staccato or more legato.

![MIDI Operations window, Change Duration page](image1)

**Transpose**

This command transposes selected MIDI notes up or down the musical scale by a specific number of semitones (half steps). With this feature, you can easily add key changes and other transposition effects to MIDI tracks.

![MIDI Operations window, Transpose page](image2)
Select/Split Notes

The Select/Split Notes command provides tools to do the following:

- Select MIDI notes based on pitch, velocity, duration, and position. These controls can be used to select a single note or note range for the entire length of a region or track.
- Split selected note and controller to the clipboard, to new tracks, or multiple new tracks based on pitch (one new track is created for each different pitch in the selection).

The Select/Split Notes window can be used to quickly extract a melody line from a keyboard performance. Or, select a drum kit or similar multi-voice performance track and automatically create multiple new tracks, one for each pitch in the selection.

Input Quantize

This command lets you quantize MIDI notes as they are performed and recorded. While this will improve the strict rhythmic accuracy of a performance, it can also give it a stiff, mechanical feel. To preserve the original rhythmic nuances of a performance, experiment with lower Strength settings, or deselect the Enable input quantize option.
Step Input
This command lets you use a MIDI controller to enter notes individually, one step at a time. This gives you precise control over note placement, duration, and velocity. With MIDI step input you can also create musical passages that might be difficult to play accurately, or at a fast tempo.

MIDI Event List
This command opens the MIDI Event List window. This floating window shows the contents of a MIDI track in a single list, so you can quickly insert, edit, or locate any type of MIDI data using your computer keyboard.

MIDI Track Offsets
This command opens the MIDI Track Offsets window. This window lets you create timing offsets for MIDI tracks to compensate for MIDI-to-audio latencies in hardware-based or software-based MIDI synthesizers.
By configuring a MIDI offset, you can make MIDI tracks play back slightly earlier (by a specific number of samples), thereby compensating for any audio monitoring latencies. MIDI offsets affect playback only and do not alter how MIDI data is displayed in the Edit window.

**MIDI Real-Time Properties**

This command opens the Real-Time Properties window. This window lets you adjust and apply MIDI quantization, duration, delay, velocity, and transposition parameters during playback.

**Remove Duplicate Notes**

The Remove Duplicate Notes command lets you quickly identify and remove MIDI notes that were unintentional “double-hits.”

If a note starts within the first 25% of the duration of a note of the same pitch which is already sounding (or within an eighth-note, whichever is shorter), it is considered a duplicate and is combined with the previous note. If a note starts later than 25% of the duration, it is considered to be a new, distinct note, and is shortened so that it ends at the same tick at which the next note starts.

**Beat Detective**

This command opens the Beat Detective window. Beat Detective automatically detects the tempo of a session and conforms an audio track or selection to that tempo by separating it into regions and aligning it to the beats. Beat Detective is ideal for tailoring a performance to a groove. For detailed information about Beat Detective, refer to the *Pro Tools Reference Guide*.

**Identify Beat**

This command lets you establish a tempo/meter map for audio that was recorded without listening to a click, or for imported audio with unknown tempos.

The Identify Beat command analyzes a selection range (usually with a distinct number of beats or measures) and calculates its tempo based on the specified meter. In doing this, Bar|Beat markers for the calculated tempo are inserted and appear in the Tempo Ruler at the beginning and end of the selection. In addition, meter events are inserted into the Meter Ruler.
**Renumber Bars**

This command lets you renumber the bars in the session, effectively changing the bar locations for all regions, meter and tempo events while leaving their position intact. In doing so, however, the SMPTE and sample locations of the session data are not changed.

![Renumber Bars dialog]

**All MIDI Notes Off**

This command sends an All Notes Off MIDI message to all MIDI devices connected to your system to silence any stuck notes.
Chapter 8: AudioSuite Menu

AudioSuite Menu

The AudioSuite menu allows you to access all AudioSuite plug-ins currently installed in your system’s Plug-Ins folder. AudioSuite plug-ins are non-real-time, file-based processing plug-ins for Pro Tools.

This chapter includes all the AudioSuite plug-in categories and the DigiRack plug-ins that are included in them.

For details on each of the AudioSuite plug-ins, refer to the DigiRack Plug-Ins Guide.

EQ Plug-Ins

1 Band, 2–4 Band, and 7 Band EQ III

The EQ III plug-ins adjust the frequency spectrum of an audio selection. These plug-ins are flexible EQ types for maximum CPU and DSP efficiency.

On the 1 Band EQ, the EQ Type selector lets you choose any one of six available filter types: High-Pass, Notch, High-Shelf, Low-Shelf, Peak, and Low-Pass.

On the 7 Band EQ and the 2–4 Band EQ, the HPF, LPF, LF, and HF sections have EQ Type selectors to toggle between the two available filter types in each section.
**1-Band EQ II and 4-Band EQ II**

The EQ II plug-ins adjust the frequency spectrum of an audio selection. The 1-band EQ can be configured as a high-pass, low-shelf, high-shelf, low-pass, or peak EQ. The 4-band EQ provides one high-shelf, one low-shelf, and two peak EQs.

**Dynamics Plug-Ins**

**Compressor II**

The Compressor II plug-in reduces the dynamic range of signals that exceed a selected threshold by a specific amount.

**DeEsser**

The DeEsser plug-in reduces sibilants (“s,” “sh,” and “t” sounds) and other high frequency noises that can occur in vocals, voice-overs, and some wind instruments. These sounds can cause peaks in an audio signal and lead to distortion.

The DeEsser reduces these unwanted sounds using fast-acting compression. A Threshold control sets the level above which compression starts, and a Frequency control sets the frequency band in which the DeEsser operates.

**Expander-Gate II**

The Expander-Gate II plug-in is useful for reducing noise or signal leakage that creeps into recorded material as its level falls, as often occurs in the case of headphone leakage.

**Gate II**

The Gate II plug-in is useful for noise removal on individual tracks, and can be used for special effects such as cutting off a reverb tail.

**Limiter II**

The Limiter II plug-in is used to prevent signal peaks from ever exceeding a chosen level so that they do not overload amplifiers or recording devices.

**Pitch Shift Plug-Ins**

**Pitch Shift**

The Pitch Shift plug-in changes the pitch of the currently selected region, with or without changing its duration. It also allows you to perform Time Compression/Expansion on your selection simultaneously with a pitch change.

**Reverb Plug-Ins**

**D-Verb**

D-Verb is a studio-quality reverb. Reverberation processing can simulate the complex natural reflections and echoes that occur after a sound has been produced, imparting a sense of an acoustic environment. D-Verb artificially creates a sound space with a specific acoustic character.
Chapter 8: AudioSuite Menu

Delay Plug-Ins

Delay
The Delay plug-in provides time delay-based effects, with up to 10.9 seconds of delay (regardless of the sample rate). In addition to long delays, you can create many delay-based effects with this plug-in, including slap echo, doubling, chorusing, and flanging.

Multi-Tap Delay
The Multi-Tap Delay plug-in adds up to four independently-controllable delays or taps to the original audio signal. By allowing you to individually control the delay time and number of repetitions of each of the four taps, the Multi-Tap delay provides greater flexibility than standard single-delay devices.

Ping-Pong Delay
The Ping-Pong Delay plug-in modifies an audio signal by adding a controllable delay to the original signal. It is ideal for adding spatialization, and when used in stereo, adds panned echo to virtually any instrument. In stereo mode, this plug-in will feed back delayed signals to their opposite channels, creating a characteristic ping-pong echo effect.

Modulation Plug-Ins

Chorus
The Chorus plug-in modifies an audio signal by combining a time-delayed, pitch-shifted copy with the original signal. It is ideal for thickening and adding a shimmering quality to guitars, keyboards, and other instruments.

Flanger
The Flanger plug-in combines a time-delayed, pitch shifted copy of an audio signal with itself. The Flanger differs from other digital flangers in that it uses a thru-zero flanging algorithm that results in a truer tape-like flange. This technique delays the original dry signal very slightly (approximately 256 samples), then modulates the delayed signal back and forth in time in relation to the dry signal, passing through its zero point on the way.

Harmonic Plug-Ins

Harmonic plug-ins include plug-ins that change the harmonic quality of audio (such as Aphex Aural Exciter).

Noise Reduction Plug-Ins

Noise Reduction plug-ins (such as Sonic No-NOISE) are used for removing pops, clicks, hum, and other unwanted noise that occur in audio.

Instrument Plug-Ins

Instrument plug-ins include soft synths or re-combinatorial rhythm machines (such as Digidesign’s Synchronic plug-in).
Other Plug-Ins

The Other Plug-In category includes plug-ins that do not fit into a standard category, or are third party plug-ins that have not had a category designated to them by their manufacturer.

DC Offset Removal

The DC Offset Removal plug-in recognizes and removes spikes caused by DC offset in the currently selected region if any are present.

Duplicate

The Duplicate plug-in duplicates a selected area or region in place. The Duplicate plug-in is useful for creating a single audio file from a selection encompassing many smaller regions with areas of silence between them.

Gain

The Gain plug-in adjusts the gain (volume) of the currently selected region in decibels or a percentage value.

Invert

The Invert plug-in inverts the phase (polarity) of the currently selected region.

Normalize

The Normalize plug-in uniformly adjusts all levels in the currently selected area to a user-definable level, referencing the loudest peak in either a specific region, or examining the relative peak level of several regions.

Reverse

The Reverse plug-in rewrites the currently selected region in reverse, producing a backwards audio effect.

Signal Generator

The Signal Generator plug-in produces audio test tones in a variety of frequencies, waveforms, and amplitudes. It is useful for generating reference signals with which to calibrate various elements of your studio.

Time Compression/Expansion

The Time Compression/ Expansion plug-in changes the length (duration) of the currently selected region, with or without changing its pitch.
Options Menu

The Options menu commands let you select several editing, recording, monitoring, playback, and display options.

Destructive Record

In Destructive Record mode, recording over existing regions replaces the original audio permanently. This allows you to conserve hard drive space. However, if you have sufficient drive space, it is usually best to disable Destructive Record mode, and use Pro Tools in Nondestructive Record mode to avoid losing any previously recorded material.

Loop Record

Loop Record lets you record take after take while the same section of audio repeats. This is a convenient technique for quickly recording multiple takes of a part without losing spontaneity.

The time range that is looped and recorded—which must be at least one second in length—is defined by selecting a range in the Ruler or in a track’s playlist, or by specifying start and end points in the Transport window.

QuickPunch

QuickPunch lets you instantaneously punch-in (initiate recording) on a record-enabled audio track during playback, then punch-out (exit recording) by clicking the Transport’s Record button. Recording with QuickPunch is nondestructive.
TrackPunch
(Pro Tools HD Only)

TrackPunch lets you punch individual tracks in, punch individual tracks out, and take tracks out of record enable without interrupting online recording and playback. Recording with TrackPunch is nondestructive.

Transport Online

This command arms the Pro Tools Transport for online synchronization. Playback or recording can then be triggered by an external time code source. Online recording or playback begins as soon as Pro Tools receives and locks to time code or ADAT sync.

Video/Movie Track Online
(Pro Tools HD Only)

This command enables and disables playback of a QuickTime movie or Avid Video. You may want to do this to have the movie or video frozen at a particular point in time relative to Pro Tools playback, or to give highest screen update priority to other Pro Tools tasks such as metering, moving faders, and so on.

Movie Track Online
(Pro Tools LE and M-Powered Only)

This command enables and disables QuickTime movie playback. You may want to do this to have the movie frozen at a particular point in time relative to Pro Tools playback, or to give highest screen update priority to other Pro Tools tasks such as metering, moving faders, and so on.

QuickTime DV Out FireWire
(Macintosh Only)

This command plays the current movie out the FireWire port. You may want to do this to have a Digital Video deck, monitor, or camcorder record or display DV (digital video) playback from Pro Tools.

For a list or supported DV FireWire transcoders, visit the compatibility pages on the Digidesign Web site (www.digidesign.com).

Pre/Post-Roll

This option enables pre- and post-roll playback. Pre- and post-roll amounts can be entered in the Transport window, set from a track’s playlist or Timebase Ruler, or by recalling a Memory Location.

Loop Playback

This option continuously loops playback of a selection until you stop playback. Looping playback is a useful way to check the rhythmic continuity of a selection when working with musical material. Selections must be at least 0.5 seconds in length to use Loop Playback.
Chapter 9: Options Menu

Scrolling
Pro Tools provides several options for defining how the contents of the Edit window scroll during playback and recording. These include:

None
The None option disables scrolling during and after playback. With this option enabled, the playback cursor moves across the Edit window, indicating the playback location, up to the right edge of the Edit window. When the play point moves beyond the right edge of the Edit window, the Playback Cursor Locator icons appear at the right edge of the Main Timebase Ruler.

After Playback
The Scrolling After Playback option causes the Edit window to scroll to the final playback location after playback has stopped. With this option enabled, the playback cursor moves across the Edit window, indicating the playback location.

Page
The Page Scrolling option causes the Edit window to scroll during playback. With this option enabled, the playback cursor moves across the Edit window, indicating the playback location. When the right edge of the Edit window is reached, its entire contents are scrolled, and the playback cursor continues moving from the left edge of the window.

Continuous
(Pro Tools HD Only)
The Continuous Scrolling option causes the Edit window’s contents to scroll continuously past the playback cursor, which remains in the center of the window. With this option enabled, playback is always based on the Timeline selection (Playhead).

Center Playhead
(Pro Tools HD Only)
This option causes the Edit window’s contents to scroll continuously past the Playhead, which is a blue line in the center of the window (red when recording).

Link Timeline and Edit Selection
This option lets you link or unlink any Timeline selection with any Edit selection.

When Link Timeline and Edit Selection is enabled, making a selection in a track’s playlist (an Edit selection) also defines the play and record range (the Timeline selection).

When Link Timeline and Edit Selection is disabled, you can make a selection within a track for editing purposes that is distinct from the selection in the Timeline (which determines the playback and recording range).

Regardless of which Scrolling option is selected in the Options menu, Pro Tools does not scroll when zoomed down to the sample level.
Link Track and Edit Selection

This option lets you link or unlink any track selection with any Edit selection.

When Link Track and Edit Selection is enabled, you can make an Edit selection within a track or across multiple tracks and each associated track is selected.

When Link Track and Timeline Selection is disabled, making an Edit selection does not automatically select all associated tracks.

Mirror MIDI Editing

This option lets you edit MIDI regions and have your edits automatically applied to every MIDI region of the same name. This can be particularly useful when editing looped MIDI regions.

Automation Follows Edit

When this option is disabled, automation events are not affected by edits to audio or MIDI notes. When enabled, automation events are affected by edits to audio or MIDI notes.

Click

When the Click command is enabled, a metronome event is generated during playback and recording. The metronome can trigger an external MIDI device (as specified by the Output setting in the Click Options dialog) or the DigiRack Click TDM or RTAS plug-in (see the DigiRack Plug-Ins Guide).

MIDI Thru

Enabling the MIDI Thru command routes MIDI from your controllers to the devices and channels assigned to the MIDI track currently record-enabled. This allows you to monitor MIDI tracks while recording.

Mute Frees Assigned Voice

(Pro Tools HD Only)

When this option is enabled, a muted track’s voice will be allocated to the next highest priority track assigned to the same explicit voice.

Auto-Spot Regions

(Pro Tools HD and Pro Tools LE with DV Toolkit Only)

When enabled, this option simplifies the task of spotting regions. If you are using VITC with this option enabled, or MachineControl software, you can pause your video at an appropriate SMPTE frame location, click on a region with the Grabber, and the region will be automatically spotted to the current time code location.

Pre-Fader Metering

This option toggles track metering between pre- and post-fader operation. When set to Pre-Fader Metering, level meters show levels independent of fader position. With post-fader metering, the level meters respond to fader position. This option only affects on-screen meters.
Solo Mode
(Pro Tools HD Only)
Pro Tools provides several modes for defining how track Solo buttons work.

SIP (Solo In Place)
When this mode is enabled, the Solo button mutes other tracks so that the chosen track can be auditioned alone.

AFL (After Fader Listen)
When this mode is enabled, the Solo button routes the track’s post-fader/post-pan signal to the AFL/PFL Path output, which is set in I/O Setup.

⚠️ AFL Solo mode requires the Surround Mixer plug-in (see the Pro Tools Reference Guide for installation information).

PFL (Pre Fader Listen)
When this mode is enabled, the Solo button routes the track’s pre-fader/pre-pan signal to the AFL/PFL Path output, which is set in I/O Setup.

⚠️ AFL Solo mode requires the Surround Mixer plug-in (see the Pro Tools Reference Guide for installation information).

Calibration Mode
(Pro Tools HD Only)
Use Calibration Mode in Pro Tools to adjust the input and output levels for your audio interface (such as the 192 I/O or the 888|24 I/O) so they match those of your mixing console and other audio devices in your studio.

Delay Compensation
(Pro Tools HD Only)
When this option is enabled, Pro Tools captures reported plug-in delays and signal routing for all tracks and calculates the correct delay for each track, compensating all the tracks accordingly.

Low Latency Monitoring
(Dig! 002 and Dig! 002 Rack Only)
Dig! 002 and Dig! 002 Rack systems can use the Low Latency Monitoring option to record with an extremely small amount of monitoring latency, to as many tracks as each system supports.
Setup Menu

This menu lets you open dialogs and windows or choose commands for configuring various Pro Tools hardware and software parameters.

Setup

- Hardware...
- Playback Engine...
- Disk Allocation...
- Peripherals...
- I/O...
- QuickTime Movie Offset...
- Session
  - Current Time Code Position...
  - Ctrl+2
- MIDI
- Click...
- Preferences...

Hardware

The Hardware Setup dialog lets you specify settings for your hardware and sessions. Configure the settings for any audio interface connected to your Pro Tools system by selecting it from the Peripherals list.

The Main page of the Hardware Setup dialog can be used to define what physical ports are routed to Pro Tools input and output channels. The Main page also provides controls for Session Sample Rate, Clock settings, and defining whether Expansion Port or Legacy Port peripherals are active (Pro Tools HD only).

Hardware Setup dialog, Main page

With Pro Tools|HD, additional pages can be used to configure other parameters on each audio interface (such as setting operating levels). Refer to the Getting Started Guide for your Pro Tools system.
Playback Engine

This Playback Engine lets you set a hardware buffer size, define the RTAS Processors allocation on multi-processor computers, and allocate a percentage of CPU resources for these tasks.

On Pro Tools|HD systems, you can select the number of voices and voiceable tracks for your system and its sessions. Voice count choices are based on how much DSP processing you want to allocate for voicing. If you change the Number Of Voices setting (Pro Tools HD only) mid-session, the session will be saved, closed, and reopened to enable the new settings.

Disk Allocation

If you are using multiple hard drives for recording, use the Disk Allocation dialog to assign each track in a session to a specific drive. Audio for that track will then be recorded to the chosen drive.

Peripherals

This Peripherals dialog provides several tabbed pages (Synchronization, Machine Control, MIDI Controller, Ethernet Controller, and Microphone Preamp) for configuring various peripheral device for use with Pro Tools (such as Digidesign’s SYNC I/O, ProControl, or PRE).

Synchronization

This page configures synchronization devices such as Digidesign’s SYNC I/O to synchronize Pro Tools to SMPTE Time Code. It also provides MIDI Machine Control (MMC) configuration for slaving Pro Tools to MMC.
Machine Control
This page configures MIDI Machine Control and 9-pin machine control devices for use with Pro Tools. MIDI Machine Control is supported on all Pro Tools systems. 9-pin Serial and Remote 9-Pin Deck Emulation modes require Digidesign MachineControl™.

MIDI Controllers
This page configures MIDI control surfaces such as the Command|8.

Ethernet Controllers
This page configures D-Control, D-Command, ProControl, Fader Packs, Edit Pack, or Control|24 for use with Pro Tools.

Mic Preamps
(Pro Tools HD Only)
This page configures one or more Digidesign PREs for use with Pro Tools.
I/O

This I/O Setup dialog provides tools to label and map Pro Tools input, output, insert, bus signal, and Mic Preamp (PRE) paths. The I/O Setup dialog also lets you configure delay compensation for hardware inserts.

Machine Track Arming Profiles
(Pro Tools HD with MachineControl Option Only)

This dialog provides extensive control over Pro Tools Track Arming. You can customize arming, track naming and mapping, and save configurations for different machines as Track Arming Profile files. These Profiles can be imported to quickly reconfigure Track Arming as needed for future projects. You can also test track mapping, and remap tracks if needed.

QuickTime Movie Offset

When you import a QuickTime movie into a session, by default, the first frame of the movie is set to the start time of the session. In some cases, you may need to offset the movie earlier or later so you can accurately spot audio to it. The Set Movie Sync Offset command allows you to set this offset in 1/4-frame increments. This is more accurate than dragging the movie track, and is especially useful in cases where a movie track begins with a partial frame.
Session

This Session Setup window lets you configure various session parameters including session start frame, SMPTE frame rate, offset settings, SYNC I/O settings (clock and pull-up/pull-down), and several time code parameters.

Current Feet+Frames Position
(Pro Tools HD and Pro Tools LE with DV Toolkit Only)

This command lets you specify a Feet+Frames value based on the current Edit cursor time code location. Typically, this feature lets test tones, pre-roll, Academy leader, and similar pre-program material to be more easily integrated into Pro Tools sessions.

Current Time Code Position
(MachineControl Option Only)

This command lets you redefine the session start time. By creating an insertion point (or selection) and then entering the desired new time code position for that location, the session start time will be recalculated based on the new, relative Time Code location.

External Time Code Offset

This command lets you compensate for devices that are consistently offset by a fixed number of frames (such as some color-corrected video masters), or for material that starts at a different time than the session.

Pro Tools provides three different types of External Time Code Offset settings. These offsets include:

- MMC (MIDI Machine Control)
- 9-Pin (Serial machine control)
- Synchronization peripherals (such as the SYNC I/O, or a MIDI interface that provide MIDI Time Code).

Positive and negative offset values can be entered to offset Pro Tools time code display later or earlier, respectively.

Unique values can be defined for each of these three types offsets, or you can link all three to adjust in unison.
MIDI

MIDI Studio

The MIDI Studio command opens the MIDI Studio Setup window (Windows) or launches the Apple Audio MIDI Setup application (Macintosh). These let you identify the MIDI devices connected to your MIDI interface.

MIDI Beat Clock

This command lets you enable synchronization for certain MIDI devices (such as drum machines, software synthesizers, and hardware sequencers) to MIDI Beat Clock. Devices selected in the MIDI Beat Clock dialog will receive the MIDI Beat Clock signal. If your MIDI interface does not support transmitting MIDI Beat Clock to separate ports, the interface will appear as the only destination.

Input Filter

This command provides settings for filtering out selected MIDI messages from your recording. The Input Filter can be set to record all messages, only the specified messages, or all except the specified messages. When using the Only option, only the MIDI messages that are selected will be recorded. Conversely, when using the All Except option, the selected messages will not be recorded.
**Input Devices**

This command enables selected MIDI controllers and control surfaces so that MIDI data received from them can be recorded. Disabling devices in this dialog will ensure that unwanted notes (such as those from drum machines or an arpeggiator) are not recorded.

**Click**

This command lets you configure metronome parameters such as MIDI note, velocity, duration, and output. If you are using the Click plug-in, set the output to None.
Preferences

The Preferences dialog has several tabbed pages in which you can specify your preferred settings for various session parameters. Each new session will use these preferences.

Display Preferences

Basics Section

Edit Window Follows Bank Selection Causes Pro Tools to scroll the Edit window to display the selected bank of tracks when you switch banks on the MIDI controller, ensuring that the current selection of tracks in the current bank is viewable on-screen. This option is only available if you are using D-Control, ProControl, Control|24, or a MIDI control surface that supports Bank chasing.

Mix Window Follows Bank Selection Causes Pro Tools to scroll the Mix window to display the selected bank of tracks when you switch banks on a supported MIDI or Ethernet controller, ensuring that the current bank is viewable on-screen. This option is only available if you are using D-Control, ProControl, Control|24, or a MIDI control surface that supports Bank chasing.

“Scroll To Track” Banks Controllers Causes supported control surfaces to bank faders to a track position number selected through the Scroll To Track command.

Track Position Numbers Stay with Hidden Tracks When enabled, tracks keep their track numbers even when hidden. When not enabled, numbers are only assigned to tracks that are shown. In this case, active tracks are then numbered sequentially, and hidden tracks are un-numbered.

Show Meters in Sends View When the Sends View is displaying individual send controls, you can select this option to show send level meters. Deselecting this option can help speed up screen redraws and processing.

Draw Grids in Edit Window Adds grid lines to the Edit window. Grid line resolution is based on the zoom level of the Edit window.

Draw Waveforms Rectified Displays audio waveform data in rectified view. In this view, audio waveforms are displayed so that their positive and negative waveform excursions (the portions that fall above and below the center line) are summed together and viewed as a single positive-value signal. This view allows more waveform detail to be seen in either normal or reduced track height views. It can be particularly useful when editing volume automation data, since it depicts waveform levels as starting at the bottom of the track.

Recompute Invalid Overviews Prompts Pro Tools to look for missing or corrupted overview data (the data used to create waveform displays) when it opens sessions. If Pro Tools finds that overview data is missing or corrupted, it will re-
create one or more overviews for the session. This may take some time if there are many tracks in the session. If you suspect that overview data for a session has become corrupted, or if you import audio files which have no overview data into a session, make sure this preference is enabled for the session, save and close the session, then reopen it. Pro Tools will recreate any overviews for the session when it opens.

**Always Display Marker Colors**
Lets you choose to view Marker colors in the Markers ruler, regardless of the settings you choose for Default Region Color Coding.

**Tool Tips Display**

**Function** Configures Tool Tip to show the basic function of the item.

**Details** Configures Tool Tip to show the complete name of an abbreviated name or item. Details view can also show the hidden or abbreviated value of parameters, as well as input and output assignments.

**Other Options Section**

**Edit Window Default Length**
Lets you set a default length for the Edit window in hours, minutes, seconds, and frames (the frames value is available with Pro Tools HD and Pro Tools LE with DV Toolkit only). This capability is useful if you wish to assemble a session of a particular length or leave extra room to expand the Edit window’s work area in your session. The maximum length is 13 hours at 48 kHz, and proportionally less at higher sampling rates.

**Delay Compensation Mode (Pro Tools HD Only)**
This option lets you choose whether information in the Delay Manager is displayed in milliseconds or samples. This option is only available when Delay Compensation is enabled (Options > Delay Compensation).

**“Organize Plug-In Menus By” Option**
This preference customizes how plug-in lists (plug-in menus) are organized in the Insert Selector or Plug-In Selector.

**Flat List** Organizes plug-ins in a single list, in alphabetical order.

**Category** Organizes plug-ins by process category (such as EQ, Dynamics, and Delay), with individual plug-ins listed in the category submenus. Plug-Ins that do not have a Category defined will appear in the “Other” Category folder.

**Manufacturer** Organizes plug-ins by their manufacturer (such as Digidesign, Eventide, Line 6, McDSP), with individual plug-ins listed in the manufacturer submenus. Plug-Ins that do not have a Manufacturer defined will appear in the “Other” manufacturer folder.

Most Digidesign-distributed third party plug-ins will be sorted as Digidesign when view by manufacturer is enabled.

**Category and Manufacturer** Organizes plug-ins in two levels of menus. The top menus display plug-ins by process category (such as EQ, Dynamics, and Delay), with individual plug-ins listed in the category submenus. The bottom menus display plug-ins by their manufacturer (such as Digidesign, Eventide, Line 6, McDSP), with individual plug-ins listed in the manufacturer submenus.

**Default Track Color Coding**
These color coding options determine the default color coding assignment for tracks in the Edit and Mix windows. Choices are:

**None** Turns off default color assignment for tracks.
Tracks and MIDI Channels Assigns a color to each track in the Edit or Mix window according to its voice assignment or MIDI channel assignment.

Tracks and MIDI Devices Assigns a color to each track in the Edit or Mix window according to its voice assignment or MIDI device assignment.

Groups Assigns a color to each track according to its group ID. If groups are suspended using the Suspend Groups command, the tracks color bars are not shown.

Track Type Assigns a color to each track according to its type (audio, Auxiliary Input, MIDI, Instrument, or Master Fader).

Default Region Color Coding These color coding options determine the default color coding assignment for regions in the track playlist. Choices are:

None Turns off default color assignment for regions. Regions are drawn with black waveform or MIDI notes on a light gray background.

Tracks and MIDI Channels Assigns a color to each region in the Edit window according to its voice or MIDI channel assignment.

Tracks and MIDI Devices Assigns a color to each region in the Edit window according to its voice assignment or MIDI device assignment.

Groups Assigns a color to each region according to the group ID of its track. If groups are suspended using the Suspend Groups command, all regions display black waveforms or MIDI notes on a light gray background.

Track Color Assigns a region color based on the color assigned to the track.

Marker Locations Assigns a color to data across all tracks based on the nearest preceding marker.

Region List Color Assigns a color to each region based on its color in the Region List.

Peak Hold Options These options determine how long the peak indicators on track meters stay lit after a peak is detected. Choices are:

3-Second When selected, track meters display the last peak level for three seconds.

Infinite When selected, track meters display the last peak level until you click them to clear them.

None When selected, track meters do not hold the peak level.

Clip Indication Options These options determine how long clip indicators on the track meters, plug-in header LEDs, track names in the Show/Hide window and Insert and send buttons stay lit after a clip is detected. Choices are:

3-Second When selected, clipping indication displays for three seconds.

Infinite When selected, clipping indication displays until you clear the clip.

None When selected, clipping is not shown.
**Operation Preferences**

**Timeline Insertion Follows Playback** When selected, causes the screen’s play cursor to update its location to the point where playback stops.

**Edit Insertion Follows Scrub/Shuttle** When selected, the edit cursor automatically locates to the point where scrubbing stops.

**Sends Default to –INF** When selected, sets the initial fader level of newly-created Sends to –∞ (no audible signal level).

**Audio During Fast Forward/Rewind** When selected, audio is audible during fast forward or rewind.

**Convert Imported “WAV” Files To AES31/BroadcastWave** When selected, this option applies to all newly imported WAV files, making them compliant with the AES31/EBU Broadcast standard.

**Automatically Copy Files on Import** When selected, Pro Tools copies all imported audio files to the current session’s Audio Files folder, regardless of whether they need to be converted to the current session’s file type, bit depth or sample rate.

**Audio Track RecordLock** When selected, audio tracks remain record enabled when playback or recording stops.

When deselected, record enabled audio tracks are taken out of record enable when Pro Tools is stopped.

**Transport RecordLock** When de-selected, the Transport Record disarms when Pro Tools is stopped due to playback or recording being stopped, or due to loss of time code. This replicates standard Pro Tools recording behavior.

When this setting is selected, the Transport Record remains armed when playback or recording stops, emulating digital dubber behavior.

**Latch Record Enable Buttons** When deselected, prevents multiple tracks from being record-enabled. Record-enabling a track takes any other track out of record-enabled mode.

**Link Mix and Edit Group Enables** When selected, links enabling and disabling of Mix and Edit groups: Enabling Group A in the Edit Window automatically enables Group A in the Mix window.

**Link Record and Play Faders** When selected, Pro Tools does not keep track of separate record and play levels for audio tracks: Record enabling a track has no effect on the fader level.

**Use F11 Key for Wait for Note** When selected, pressing the F11 Function key puts MIDI recording in Wait for Note mode.

**Disable “Input” When Disarming Track (In “Stop”)** When selected, input monitoring is turned off when a track is disarmed.
Mute Record-Armed Tracks While Stopped  This setting determines monitor status of record-enabled tracks.

- When enabled, Pro Tools mutes tracks that are record-enabled when the Transport is stopped. Input can still be monitored while stopped using the TrackInput button.
- When not enabled, Pro Tools monitors audio input on tracks that are record-enabled.

Avid Video Errors Stop Playback  If selected, Pro Tools automatically stop playback of audio and video if a single frame of video is dropped.

If unselected, Pro Tools continues playback of audio even if frames are dropped. In most cases, video playback will recover within a few frames and continue playing audio and video in sync.

Numeric Keypad Mode

The Numeric Keypad mode determines how the numeric keypad functions. You can always use the numeric keypad to select and enter values in the Event Edit Area, Location Indicators, and Transport fields.

Classic Emulates the way Pro Tools worked in versions earlier than 5.0. With the Numeric Keypad mode set to Classic, you can play up to two tracks of audio in Shuttle Lock mode. Press Control (Macintosh) or the Start key (Windows), followed by 0–9 for different play speeds. Press Plus (+) or Minus (–) to reverse direction. Recall Memory Locations by typing period (.), the Memory Location number, and period (.) again.

Transport Lets you set a number of record and play functions, and also operate the Transport from the numeric keypad. With the Numeric Keypad mode set to Transport, you can play up to two tracks of audio in Shuttle Lock mode. Press Control (Macintosh) or the Start key (Windows), followed by 0–9 for different play speeds. Press Plus (+) or Minus (–) to reverse direction. Recall Memory Locations by typing period (.), the Memory Location number, and period (.) again.

Shuttle Selects a type of shuttling different from that of Shuttle Lock mode. With the Numeric Keypad mode set to Shuttle, playback is triggered by pressing and holding the keys on the numeric keypad—playback stops once the keys are released. Various playback speeds are available in both forward and reverse. You can also recall Memory Locations by typing period (.), the Memory Location number, and period (.) again.

Autosave

This preference determines how the Autosave feature functions.

Enable Session File Auto Backup When selected, Pro Tools automatically saves backups of your Pro Tools session file while you work. Backups are saved to in the Session Files Backup folder in your session folder. Use the Keep and Backup Every fields to specify the total number of incremental backups that are kept and how often the session is saved.
Online Options

Record Online at Time Code (or ADAT) Lock When selected, online recording begins as soon as Pro Tools receives and locks to time code or ADAT sync.

Record Online at Insertion/Selection When selected, online recording begins at the Edit cursor location. Recording continues until Pro Tools stops receiving time code. If you make a selection, Pro Tools records online for the length of the selection.

Open Ended Record Allocation Options
This preference determines how much of your available hard drive space is allocated for recording. Choices are:

Use All Available Space When selected, the drive’s entire available space is allocated. This can sometimes slow down the recording process for hard drives that use certain file systems, including HFS+ and NTFS.

Limit To Sets the maximum allowable recording duration. This can help reduce the time it takes to begin recording by allocating only a portion of your hard drive. The number of minutes specified is allocated for each record-enabled track. You may find it necessary to experiment with this number to achieve the desired performance for recording.

QuickTime Playback Priority Options

Normal This is the default setting for QuickTime Movie Playback Priority. It gives no extra priority to movie playback over other screen update tasks such as metering, moving faders, and so on. In most cases you should use this setting. If, however, you are running QuickTime movies without a video capture card, you may need to use the Higher or Highest Playback Priority setting.

Higher This command gives QuickTime movie playback a higher priority relative to other Pro Tools screen update tasks. This yields better movie playback performance if you are running QuickTime movies without a video capture card.

Highest This command gives QuickTime movie playback highest priority. In this mode, Pro Tools disables screen activity such as metering during movie playback. This yields the highest movie playback performance if you are running QuickTime movies without a video capture card.

Additional Options

Custom Shuttle Lock Speed Sets the highest fast-forward Shuttle Lock speed (key 9) for Shuttle Lock modes (Classic or Transport). The range for this setting is 50–800%.

Calibration Reference Level (Pro Tools HD Only) Sets a default calibration reference level in dB when Pro Tools is in Calibration mode. For audio interfaces that have physical trim controls (such as the 192 I/O and 888|24 I/O), see the interface’s guide for calibration instructions.

Auto Regions Fade In/Out Length Sets a default length for fade-ins and fade-outs automatically applied to region boundaries. Using automatic fade-ins and fade-outs saves you the trouble of editing to zero-crossings or creating numerous rendered fades in order to eliminate clicks or pops in playback. Autofades are not written to disk. Value range is from 0–10 ms for the Auto Region Fade In/Out Length. A value of zero means that no auto-fading will occur. The Auto Fade value is saved with the session, and is automatically applied to all free-standing region boundaries until you change it.
**Back/Forward Amount** Sets the default length of Back, Back and Play, Forward and Forward and Play. The Back/Forward Amount defaults to follow the main time scale, or Follow Main Time can be unchecked and a specific timebase format can be selected: Bars:Beats, Min:Sec, Time Code, Feet+Frames, or Samples.

**Solo Latch Options**

This preference determines if solos are *latched*, unlatched, or added temporarily (Pro Tools HD only).

**Latch** When selected, pressing subsequent Solo buttons does not cancel previously pressed solos.

**Momentary (Pro Tools HD with Supported Control Surfaces Only)** When selected, the Solo button is not sticky. When the Solo button is held down, the track is soloed. Additional tracks can be soloed by touching their Solo buttons (as long as at least one Solo button is held down). When no Solo button is held down, all soloed tracks will unsolo.

**X–OR ( Cancels Previous Solos)** When selected, pressing subsequent Solo buttons cancels previous solos.

**Editing Preferences**

**Recall Memory Location Selection at Original Track** When selected, Memory Locations that recall a selection also recall the track in which the selection was made.

**Auto-Name Memory Locations When Playing** When selected, Pro Tools gives new memory locations default names based on their time location in the session. The time units currently chosen in the View menu determine the units for the names.

**Auto-Name Separated Regions** When selected, Pro Tools automatically names newly separated regions by appending a number to the region’s name. Disabling this option can be useful when importing region groups, REX files, or ACID files, because these file types can contain so many separate regions that it becomes difficult to read the Region List.
Region List Selection Follows Edit Selection
When selected, selecting a region in a track also selects it in the Region List.

Edit Selection Follows Region List Selection
When selected, selecting a region in the Region List causes Pro Tools to highlight that region’s occurrence in a track.

Crossfade Preview Pre-Roll
This option specifies the amount of pre-roll to be added when you are auditioning crossfades in the Fades dialog.

Crossfade Preview Post-Roll
This option specifies the amount of post-roll to be added when you are auditioning crossfades in the Fades dialog.

Default Fade Settings
Fade In Selects the default envelope shape for fade-ins.

Crossfade Selects the default envelope shape for crossfades.

Fade Out Selects the default envelope shape for fade-outs.

Conversion Quality
Selects the sample rate conversion quality. Sample rate conversion is used in a variety of Pro Tools processes, including converting and importing audio files of different formats into a session, and bouncing and saving tracks to a different sample rate or bit depth. The higher the quality of sample rate conversion you choose, the longer Pro Tools will take to process the audio file.

“Matching Start Time” Takes List
Control-clicking (Windows) or Command-clicking (Macintosh) in a track displays a list of regions whose time stamp matches the current cursor location. The following options determine which takes appear in this list:

Take Region Name(s) That Match Track Names
When selected, only regions that share the same root name with the track and playlist appear in the Takes List pop-up menu.

Take Region Lengths That Match
When selected, only regions that match the length of the current selection appear in the Takes List pop-up menu.

“Separate Region” Operates On All Related Takes
When selected, editing a region with the Separate Region command also affects all other related takes with the same User Time Stamp. This option helps you compare different sections from a group of related takes.

QuickPunch/TrackPunch Crossfade Length
This option lets you specify a default length for crossfades created by QuickPunch and TrackPunch recording. Crossfades occur before the punch in and after the punch out.

Levels Of Undo
This option lets you set the maximum number of actions (up to 32) that can be undone with the multiple undo feature.
Automation Preferences

Faders Move During Playback When selected, faders move on-screen when automated. When deselected, faders do not move, but automation is still functioning.

Smooth and Thin Data After Pass When selected, automation is automatically smoothed and thinned by the amount specified with the Degree of Thinning option.

Mutes Follow Groups When selected, muting a track that belongs to a Mix group mutes all other members of the group. When deselected, tracks must be muted individually.

Solos Follow Groups When selected, soloing a track that belongs to a Mix group solos all other members of the group. When deselected, tracks must be soloed individually.

Send Mutes Follow Groups When selected, muting a Send that belongs to a group mutes all other members of the group. When deselected, Sends must be muted individually.

Send Levels Follow Groups When selected, adjusting the level of a Send that belongs to a group adjusts the Send levels of all other members of the group. When deselected, Send levels must be adjusted individually.

LFEs Follow Groups When selected, adjusting or editing an LFE (Low Frequency Effects) control of a track or send that belongs to a Mix group adjusts the LFE controls of all members of the group. When deselected, LFE controls must be adjusted individually.

After Write Pass, Switch To (Pro Tools HD Only)

Selects the Automation mode that Pro Tools tracks automatically switch to after an automation pass in Write mode. You can choose to switch to Touch or Latch mode, or stay in Write mode by selecting No Change.

“The After Write Pass, Switch To” setting also affects Write/Trim mode. After a Write/Trim automation pass, the Write/Trim tracks automatically switch to Latch/Trim, Touch/Trim, or remain in Write/Trim.

Degree of Thinning Specifies the amount of thinning performed on automation data when automation is recorded. Avoid over thinning automation data or it may no longer accurately reflect the original pass.

Touch Timeout Specifies how quickly automation recording stops or “times out” after you stop moving a control surface in Touch mode.

AutoMatch Time Specifies how quickly Pro Tools returns a fader or other control to its previously automated level after automation recording stops.
AutoGlide Time Specifies the time it takes to glide from point to point (from the Pan Location cursor to the new destination), when using AutoGlide mode in the Surround Panner.

Amount of Memory for Automation Recording Lets you reserve additional memory for recording automation. If you have dense automation data or a large number of automated tracks, increase this amount. Relaunch Pro Tools for this setting to take effect.

**Processing Preferences**

![Processing Preferences page](image)

AudioSuite Dither

Use AudioSuite Dither When selected, applies a selectable dither plug-in to specific AudioSuite processing tasks (such as Gain and Normalize).

Dither Plug-In Specifies the plug-in used for dither processing when the Use AudioSuite Dither option is selected.

Edit Settings When a Digidesign dithering plug-in is used, allows you to apply either normal or noise-shaping dither.

Bit Depth

16-, 18-, 20-, and 24-Bit Lets you select a bit depth for the dithered audio.

AudioSuite Buffer Size

AudioSuite Buffer Size sets the size of the memory buffer used for audio processing and previewing with AudioSuite plug-ins. Generally, choosing a smaller buffer speeds up AudioSuite audio previewing functions. Choosing a larger buffer speeds up AudioSuite processing functions. Set the buffer according to your current task. Before auditioning an AudioSuite plug-in, set the buffer to Mini or Small. When you process a file, set it to Large or Jumbo.

TC/E (Time Compression and Expansion)

TC/E Plug-In Allows you to choose the plug-in used for Time Compression and Expansion when you edit audio with the Time Trimmer tool. The Time Trimmer works by using Time Compression/Expansion to match an audio region to the length of another region, a tempo grid, a video scene, or other reference point.

Default Settings Specifies the default settings used by the chosen Time Compression/Expansion plug-in.
### MIDI Preferences

#### Default Note On Velocity
Sets the default Note On velocity for MIDI notes inserted in the Edit window and the MIDI Event List.

#### Pencil Tool Resolution When Drawing Controller Data
Sets the default resolution for MIDI controller data created with the Pencil. Setting this to a lower resolution helps avoid creating controller data that is unnecessarily dense. The value range is from 1 to 100 milliseconds.

#### Global MIDI Playback Offset
Sets an offset in samples to compensate for MIDI latency. Entering a value here has the same effect as setting an offset with the MIDI Track Offsets command (Event > MIDI Track Offsets). Offset values can be positive (later) or negative (earlier).

#### Default Thru Instrument
Sets the default MIDI Thru instrument. You can select a predefined device from your available MIDI instruments, or select “Follows First Selected MIDI Track” to use the assigned MIDI output of the first selected MIDI or Instrument track. When multiple MIDI or Instrument tracks are selected, the instrument in the selected track that is closest to the top of the Edit window (or closest to the left edge of the Mix window) will be used.

### General Section

#### Play MIDI Notes When Editing
When selected, causes MIDI notes to sound when you insert them with the Pencil or drag them with the Grabber.

#### Use MIDI to Tap Tempo
When selected, lets you use MIDI input to set tempo in Manual Tempo mode.

#### Display Events as Modified by Real-Time Properties
When selected, displays the effects of Real-Time Properties in both the Edit window and the MIDI Event List.

### MIDI Note Display Options

#### Standard Pitch
Sets the reference for middle C as C3.

#### Alternate Pitch
Sets the reference for middle C as C4.

#### MIDI Note Number
Sets the reference for middle C as MIDI note number 60.

### Delay for External Devices Options

#### (Pro Tools HD Only)

These options let you apply Delay Compensation to MIDI Time Code and MIDI Beat Clock output by the system. Generally, this delay should be applied when the output of the external MIDI device is mixed externally, and not when the output of the external device is mixed back into Pro Tools.

These options are only available in the MIDI Preferences page when a Delay Compensation Engine is chosen in the Playback Engine Dialog and Delay Compensation is enabled in Pro Tools.
Machine Control Preferences (Pro Tools HD Only)

Machine Chases Memory Location When selected, navigating to a specific location in a session with a Memory Location causes a connected transport to chase to that location.

Machine Follows Edit Insertion/Scrub When selected, navigating to a specific location in a session by moving the selection point or by scrubbing a track will cause a connected transport to chase to that location. Enabling Machine follows Edit Insertion/Scrub is only recommended when slaving a non-linear device to Pro Tools.

Machine Cues Intelligently When selected, if you navigate to a cue point that is more than 10 seconds from the current location, Pro Tools will command a connected transport to shuttle to the desired location at full speed to within 10 seconds of the cue point. Cueing will then slow to normal speed until the point is reached. This significantly speeds up tape cueing.

Stop At Shuttle Speed Zero When selected, Pro Tools sends a Stop command when shuttle speed equals zero.

Delay Before Locking To LTC Sets a number of frames of delay for Pro Tools to wait before attempting to lock to Linear Time Code, to compensate for the amount of time needed for the master machine to stabilize. This setting can be especially useful in a multi-machine environment.

Remote Mode

These settings affect Remote 9-Pin Deck Emulation Mode only, which requires MachineControl™.

Punch In Frame Offset Sets an offset in frames to compensate for punch in timing advances or delays.

Punch Out Frame Offset Sets an offset in frames to compensate for punch out timing advances or delays.

Delay After Play Command Sets a number of frames of delay for Pro Tools to wait before attempting to lock, to compensate for the amount of time needed for the master machine to stabilize. This setting can be especially useful in a multi-machine environment.

Ignore Track Arming Allows Pro Tools to respond to all 9-pin remote commands except track arming. Requires the Pro Tools MachineControl option.

Set Servo Lock Bit at Play (Tamura Support) Enable this option when using a Tamura synchronizer to control Pro Tools in Remote mode to minimize lock-up times during recording.
Window Menu

The Window menu provides commands to toggle the display of various Pro Tools windows: selecting the command displays the window; selecting the command again hides the window.

- **Mix**
  This command displays the Mix window, used for recording and mixing tasks.

- **Edit**
  This command displays the Edit window, used for graphical editing and arranging of audio, MIDI and automation.

- **Task Manager**
  This command displays the Task Window, used to monitor, pause, or cancel ongoing tasks.

- **Workspace**
  This command displays the Workspace browser, which can be used for searching, sorting, auditioning, and importing data. The Project, Volume, and Catalog (Pro Tools HD only) browsers can be accessed from the Workspace browser.

💡 For Window menu items, keyboard shortcuts with number keys only work using the numeric keypad on your computer.
Project
This command displays the Project Browser, used for Pro Tools file management with the current session.

For more information on the Task window, Workspace, Project, and other browsers, see the DigiBase and DigiBase Pro Guide.

Browsers
Use the Browsers command to select a currently open browser and bring it to the front. The Browsers submenu can also be used to bring all currently open browsers to the front, or send all browsers to the back. Choices include Bring to Front, and Send to Back.

Transport
This command opens the Transport window. This window can display counters, MIDI controls, and basic or expanded transport controls (configure the Transport window from View > Transport).

Big Counter
This command opens the Big Counter window. This window provides a large, easy to see reference for the current session time location. Time is displayed in the currently chosen Main Time Scale format.

Automation Enable
This command opens the Automation Enable window. This window lets you enable or suspend the writing of volume, pan, mute, plug-in, send level, send pan, and send mute automation for all tracks.

Before you can record automation, the desired automation type must be enabled. Buttons are highlighted when enabled. To suspend writing of automation, deselect the button for the desired automation type.
Memory Locations

This command opens the Memory Locations window. Here you can store up to 200 time location markers, selections, zoom settings, pre- and post-roll times, track show and hide states, track height states, and group enables. To recall a memory location, click the button for the desired location or, on your computer’s numeric keypad, press the number of the location followed by a period (.).

Machine Track Arming

(Pro Tools HD with MachineControl Option Only)

This command opens the Machine Track Arming window on systems that have the Machine-Control option installed. When using Machine-Control, this window lets you record-arm external recording devices from within Pro Tools.

Universe

(Pro Tools HD Only)

This command opens the Universe window. This window provides a visual overview of all tracks in a session. Use the Universe window to quickly click and go to any location in a session.

Avid Video

(Pro Tools HD Only)

This command open the Video window, which displays Avid Video imported into the current session using the File > Import > Video command. The window provides a sample-accurate, random-access reference for spotting sound effects, music, Foley, dialog, or other audio to the Avid Video.

QuickTime Movie

This command opens the Movie window, which displays QuickTime movies imported into the current session using the File > Import > QuickTime Movie command. The window provides a sample-accurate, random-access reference for spotting sound effects, music, Foley, dialog, or other audio to the QuickTime movie.

Color Palette

This command opens the Color Palette window. Use this window to make color selections for tracks, regions, groups and markers.
**Undo History**

This command opens the Undo History window. Use this window to view a list of undoable and redoable operations and return to any previous state. The Undo History can show editing times, enabling you to revert to the state a session held at a particular time.

![Undo History window](image)

**Disk Space**

This command opens the Disk Space window. This window shows the recording capacity of each hard drive attached to your system, measured in track minutes. This calculation is based on the bit depth and sample rate of the current session.

![Disk Space window](image)

**System Usage**

This command opens the System Usage window. This window provides meters that indicate how much of your system’s processing power is being used in processing audio, and when writing and playing back automation.

With Pro Tools LE, these meters show PCI bus activity, CPU processing activity and Disk processing activity.

With Pro Tools HD, these meters show Activity (PCI bus activity, CPU processing activity, and Disk processing activity) and TDM Time Slot usage.

![System Usage window (Pro Tools HD shown)](image)
Help Menu


Select the title of the desired document from the Pro Tools menu to launch the document in Adobe Acrobat Reader (downloadable from www.adobe.com).
Chapter 13: Region List

The Edit Window displays all audio regions, MIDI regions, and region groups in a single, comprehensive Region List.

The pop-up menu at the top of the Region List provides general menu commands and tools for managing the contents of the list.

**Find**
Use the Find command to display all regions in a list whose names contain a particular word or phrase.

**Clear Find**
This command returns the Region List to displaying regions as they were displayed before the last Find.

**Select Parent in Project Browser**
When this command is enabled, the DigiBase Project browser automatically highlights the parent file of any file or region selected in the Region List.

This setting is latching (meaning it maintains its setting).
**Show Options**

The Region List can show different types of regions and region information. Select the Show options for the items you want to show. You can also deselect Show options to hide a type of region or region information to streamline the list of region names.

**Region Types**

- **Audio** Shows Audio regions in the Region List.
- **MIDI** Shows MIDI regions in the Region List.
- **Grouped** Shows regions that are part of a group.
- **Auto-Created** Shows automatically-created regions. These are regions that were created as a by-product of cutting, pasting, and separating other regions. Since these by-product regions can become numerous, hiding them (by deselecting the option) helps you to avoid scrolling through an unnecessarily long Region List.

**Region Information**

- **Color** Shows Track Color Coding as assigned with Default Region Color Coding option in Display Preferences page, or as assigned in the Color Palette.
- **Icon** Shows the Track Type icon for the region. The icon refers to the type of track (audio, MIDI, or Instrument) that the region is used on.
- **Timebase** Shows whether regions are tick-based or sample-based.
- **File Name** Shows the audio file from which the region originated.
- **Disk Name** Shows the name of the hard drive on which the region resides.
- **Full Path** Shows the full directory path name of the region’s location.

**Select Options**

In the Region List, you can select specific regions so they can be dragged to tracks, processed with AudioSuite plug-ins, or exported.

- **All** Selects all regions in the Region List.
- **Unused** Selects regions that have not been placed in a track in the current session. Offline regions appear in the Region List as italicized and dimmed.
- **Unused Except Whole Files** Selects regions that have not been placed in a track in the current session, but do not include Whole-file regions. Whole-file regions are regions that were created when recording or importing audio, consolidating existing regions, and when nondestructively processing with an AudioSuite plug-in. Whole-file audio regions reference an entire audio file that resides on your hard drive. Whole-file audio regions are displayed in bold in the Region List.
- **Offline** Selects regions whose parent files cannot be located, or are not available, when opening a session or importing a track. Offline regions appear in the Region List as italicized and dimmed; they appear in playlists as light blue regions with italicized names.
Sort By Options

The Sort By options let you sort regions to help keep track of large numbers of regions.

Audio regions can be sorted by:
- Region Type
- Name
- Length
- Original Time Stamp
- User Time Stamp
- Timebase
- Start in Parent
- End in Parent
- File Name
- File Length
- File Creation Date
- File Modification Date
- Disk Name (audio and region groups only)
- Track Format/Width

MIDI regions can be sorted by:
- Name, Length
- Original Time Stamp
- User Time Stamp
- Timebase
- Start in Parent
- End in Parent.

Regions can also be sorted by Region Type (Audio and MIDI), or in Ascending or Descending order.

Clear

This command lets you remove unwanted regions from the session. Whole-file regions can also be removed permanently from your hard drive.

⚠ Clearing whole-file regions is destructive and cannot be undone. It permanently removes the file from your hard drive. There is no way to recover files deleted with this command.

Rename

This command lets you rename selected regions.

When you rename a whole-file audio region, you can specify whether to rename just the region, or both the region and the disk file.

Auto Rename

This command lets you specify the auto-naming options for a region when new regions are created from it in the course of editing.

Auto-naming of regions does not affect the names of parent audio files. Instead, it stores pointers to the regions within the parent source file.

The Auto Rename command opens a dialog with the following fields:

- **Name** Determines the root name for the auto-created regions.
- **Number** Sets the start number for the sequentially numbered new regions.
- **Zeros** Determines the number of zeros that occur before the auto numbers.
- **Suffix** Specifies text to be appended to the end of the name, following the auto numbering.
**Time Stamp**

This command lets you select a region (or regions) and redefine its SMPTE time stamp. The Original Time Stamp and the User-Time Stamp are then stored with your session.

When audio is first recorded, the User Time Stamp will match the Original Time Stamp, but you can change the User Time Stamp at any time using the Time Stamp command. This feature is particularly useful in post production situations where the SMPTE time code on video “work prints” often changes from one edit revision to another.

**Compact**

The Compact command deletes unused portions of audio files to conserve disk space, and to prepare for cleaner hard drive back-ups. The Compact command also deletes audio if there are no regions referencing the data.

⚠️ The Compact command is destructive and cannot be undone. It permanently alters the original audio files. There is no way to recover data deleted with this command.

Because it permanently deletes audio data, the Compact command should be used only after you have completely finished your editing and are sure that you have no further use for the unused audio data.

The Compact Selected command can pad the regions of the compacted file by a user-selectable amount. You may want to do this because Pro Tools requires extra audio data before and after audio regions to create crossfades. So, if your regions have crossfades, or if you want to pad the regions for the sake of any future trimming, you should enter an appropriate amount of padding (in milliseconds) to allow for this.

**Export Region Definitions**

This command lets you export region definitions for audio files within each session, so that you can use an audio file’s regions in another session, or with another application that supports them.

The Export Region Definitions command does not export regions as audio files (unlike the Export Regions as Files command). Instead, it stores pointers to the regions within the parent source file.
Export Regions as Files
This command lets you export regions as audio files. Use this command if you intend to use a region in other sessions (or other audio applications) without using its parent source file.

This command also provides a way to convert regions to a different audio format, sample rate, or bit depth.

Export Region Groups
This command lets you export region groups as files. Use this command if you intend to use a region group in other sessions.

If you are exporting region groups to another hard drive, you may want to copy any referenced audio files as well. This way you can move region groups not only from one session to another, but from one system to another.

Recalculate Waveform Overviews
This command re-creates the session’s waveform overview data (the data used to create waveform displays). Use this command if you think overview data for a session has become corrupted, or if you import audio files which have no overview data into a session.

Recalculating waveform overviews may take some time if there are many tracks in the session.

Timeline Drop Order
This command sets whether tracks dragged from the Region List are dropped sequentially in a single track or spread across multiple tracks.

Top to Bottom When enabled, regions are spread across multiple destination (drop) tracks, or on new tracks (when dragging to the area below the last track or to the Track List).

Left to Right When enabled, regions are placed sequentially in a single destination (drop) track or a newly created track (when dragging to the area below the last track or to the Track List).
Numerics
1-Band EQ plug-in 41, 42
2–4 Band EQ plug-in 41
3-Second Clip preference 60
3-Second Peak Hold preference 60
4-Band EQ plug-in 42
7 Band EQ plug-in 41

A
AAF 10
About Pro Tools command 1
Add Avid Video command 24
Advanced Authoring Format 10
AFL (After Fader Listen) mode 49
After Fader Listen mode 49
After Write Pass, Switch To preference 66
All MIDI Notes Off command 40
Always Display Marker Colors option 59
Amount of Memory for Automation Recording option 67
Assignment View option 21
Audio During Fast Forward/Rewind option 61
Audio MIDI Setup 56
Audio Track RecordLock option 61
AudioSuite Buffer Size preference 67
AudioSuite Dither preferences 67
AudioSuite menu 41
  Delay plug-ins 43
  Dynamics plug-ins 42
  EQ plug-ins 41
  Harmonic plug-ins 43
  Instrument plug-ins 43
  Modulation plug-ins 43
  Noise Reduction plug-ins 43
  Other plug-ins 44
  Pitch Shift plug-ins 42
  Reverb plug-ins 42
  Auto Input Monitoring option 25
  Auto Regions Fade In/Out Length option 63
  Auto Rename Region List command 79
  AutoGlide Time option 67
  AutoMatch Time option 66
  Automatically Copy Files on Import 61
  Automation commands 15
    Copy To Send 15
    Glide to All Enabled 16
    Glide to Current 16
    Thin Automation 16
    Trim to All Enabled 16
    Trim to Current 16
    Write to All Enabled 16
    Write to Current 16
  Automation Enable Window command 72
  Automation Follows Edit option 48
  Automation Preferences page 66
  Auto-Name Memory Locations While Playing option 64
  Auto-Name Separated Regions option 64
  AutoSave option 62
  Auto-Spot Regions option 48
  Avid Video commands
    Add Video 24
    Clear Selection 25
    Clear Track 25
    Set Scrub Window Size & Location 25
    Undo Add Video 24
    Use Scrub Window 25
  Avid Video Errors Stop Playback option 62
  Avid Video Track commands 24
    New Track 24
  Avid Video Window command 73
<table>
<thead>
<tr>
<th>B</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Back/Forward Amount option</td>
<td>64</td>
</tr>
<tr>
<td>Bars:Beats Time Scale</td>
<td>21</td>
</tr>
<tr>
<td>Beat Detective command</td>
<td>39</td>
</tr>
<tr>
<td>Big Counter command</td>
<td>72</td>
</tr>
<tr>
<td>Bit Depth option for AudioSuite plug-ins</td>
<td>67</td>
</tr>
<tr>
<td>Bounce options</td>
<td></td>
</tr>
<tr>
<td>Conversion Quality</td>
<td>7</td>
</tr>
<tr>
<td>Convert After Bounce</td>
<td>7</td>
</tr>
<tr>
<td>Convert During Bounce</td>
<td>7</td>
</tr>
<tr>
<td>File Type</td>
<td>7</td>
</tr>
<tr>
<td>Format</td>
<td>7</td>
</tr>
<tr>
<td>Import After Bounce</td>
<td>7</td>
</tr>
<tr>
<td>Resolution</td>
<td>7</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>7</td>
</tr>
<tr>
<td>Source</td>
<td>6</td>
</tr>
<tr>
<td>Use Squeezer</td>
<td>7</td>
</tr>
<tr>
<td>Bounce to Disk command</td>
<td>6</td>
</tr>
<tr>
<td>Bounce to QuickTime Movie command</td>
<td>7</td>
</tr>
<tr>
<td>Bring Region to Front command</td>
<td>27</td>
</tr>
<tr>
<td>Browsers Window commands</td>
<td>72</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration Mode</td>
<td>49</td>
</tr>
<tr>
<td>Calibration Reference Level option</td>
<td>63</td>
</tr>
<tr>
<td>Capture Region command</td>
<td>28</td>
</tr>
<tr>
<td>Center Playhead Scrolling option</td>
<td>47</td>
</tr>
<tr>
<td>Change Duration command</td>
<td>36</td>
</tr>
<tr>
<td>Change Edit to Match Timeline Selection command</td>
<td>13</td>
</tr>
<tr>
<td>Change Meter command</td>
<td>32</td>
</tr>
<tr>
<td>Change Timeline to Match Edit Selection command</td>
<td>13</td>
</tr>
<tr>
<td>Change Velocity command</td>
<td>35</td>
</tr>
<tr>
<td>Chorus plug-in</td>
<td>43</td>
</tr>
<tr>
<td>Classic Numeric Keypad Mode</td>
<td>62</td>
</tr>
<tr>
<td>Clear All Clip Indicators</td>
<td>26</td>
</tr>
<tr>
<td>Clear Avid Video Selection command</td>
<td>25</td>
</tr>
<tr>
<td>Clear Avid Video Track command</td>
<td>25</td>
</tr>
<tr>
<td>Clear command</td>
<td>12</td>
</tr>
<tr>
<td>Clear Find command</td>
<td>77</td>
</tr>
<tr>
<td>Clear Region List command</td>
<td>79</td>
</tr>
<tr>
<td>Clear Special commands</td>
<td>12</td>
</tr>
<tr>
<td>All Automation</td>
<td>12</td>
</tr>
<tr>
<td>Pan Automation</td>
<td>12</td>
</tr>
<tr>
<td>Plug-In Automation</td>
<td>12</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DC Offset Removal plug-in</td>
<td>44</td>
</tr>
<tr>
<td>Default Fade Settings</td>
<td>65</td>
</tr>
<tr>
<td>Default Note On Velocity option</td>
<td>68</td>
</tr>
<tr>
<td>Default Settings TC/E preference</td>
<td>67</td>
</tr>
<tr>
<td>Default Thru Instrument option</td>
<td>68</td>
</tr>
<tr>
<td>Default Track Color Coding</td>
<td>59</td>
</tr>
<tr>
<td>Degree of Thinning option</td>
<td>66</td>
</tr>
<tr>
<td>Delay After Play Command option</td>
<td>69</td>
</tr>
</tbody>
</table>
Delay Before Locking To LTC option 69
Delay Compensation Mode option 59
Delay Compensation option 49
Delay for External Devices options 68
Delay plug-ins
  Delay 43
  Multi-Tap Delay 43
  Ping-Pong Delay 43
Delete Fades command 17
Delete Tracks command 24
destructive editing
  compacting audio files 80
Destructive Record mode 45
DigiDelivery 6
DigiRack Delay plug-in 43
Disable “Input” When Disarming Track (In “Stop”) option 61
Disk Allocation dialog 52
Disk Space view options 21
Disk Space Window command 74
Display Events as Modified by Real-Time Properties option 68
Display menu
  Narrow Mix window option 19
Display Preferences page 58
Dither Plug-In preference 67
Draw Grids in Edit Window option 58
Draw Waveforms Rectified option 58
Duplicate command 13
Duplicate plug-in 44
Duplicate Track command 24
D-Verb 42
Dynamics plug-ins
  Compressor II 42
  Expander-Gate 42
  Gate II plug-in 42
  Limiter plug-in 42
E
Edit Dither Settings preference 67
Edit Insertion Follows Scrub/Shuttle option 61
Edit menu 11
  Automation commands 15
  Clear command 12
  Clear Special commands 12
  Consolidate command 15
  Copy command 11
  Copy Special commands 12
  Cut command 11
  Cut Special commands 12
  Duplicate command 13
  Fades commands 17
  Heal Separation command 14
  Insert Silence command 13
  Paste command 11
  Paste Special commands 12
  Redo command 11
  Repeat command 13
  Select All command 13
  Selection commands 13
  Separate Region commands 14
  Shift command 13
  Strip Silence command 15
  TCE Edit to Timeline Selection command 15
  Thin Automation command 15
  Trim Region commands 13
  Undo command 11
Edit Selection Follows Region List Selection option 65
Edit Window command 71
Edit Window Default Length option 59
Edit Window Follows Bank Selection option 58
Edit Window view options 19
Editing Preferences page 64
Enable Session File Auto Backup option 62
End to Insertion 14
EQ II plug-ins 42
EQ III plug-ins 41
Ethernet Controllers page 53
Event menu
- All MIDI Notes Off command 40
- Beat Detective command 39
- Identify Beat command 39
- MIDI commands 34
- MIDI Event List command 38
- MIDI Real-Time Properties command 39
- MIDI Track Offsets command 38
- Remove Duplicate Notes command 39
- Renumber Bars command 40
- Tempo Operation commands 33
- Time commands 31
- Exit command 10
- Expanded Transport view option 21
- Expander-Gate plug-in 42
- Export commands 10
- Export MIDI command 10
- Export Region Definitions command 80
- Export Region Groups command 81
- Export Regions as Files command 81
- Export Selected Tracks as OMF/AAF command 10
- Export Session Info as Text command 10
- External Time Code Offsets command 55

File menu 3
- Bounce to commands 6
- Close Session command 4
- Exit command 10
- Export commands 10
- Export MIDI command 10
- Export Selected Tracks as OMF/AAF command 10
- Export Session Info as Text command 10
- Get Info command 10
- Import Audio from Current Movie command 9
- Import Audio from QuickTime Movie command 9
- Import Audio Region List command 9
- Import Audio to Track command 9
- Import Avid Video or QuickTime Movie command 9
- Import MIDI to Region List command 9
- Import MIDI to Track command 9
- Import QuickTime Movie command 9
- Import Region Groups command 9
- Import Session Data command 8
- New Session command 3
- Open Session command 4
- Revert to Saved command 5
- Save As command 4
- Save command 4
- Save Copy In command 4
- Send via DigiDelivery command 6
- Find Region List command 77
- Flanger plug-in 43
- Flatten Performance command 35

G
- Gain plug-in 44
- Gate II plug-in 42
- Get Info command 10
- Glide to All Enabled command 16
- Glide to Current command 16
- Global MIDI Playback Offset option 68
- Grid/Groove Quantize command 34
- Group Region command 28
- Group Track command 23
Hardware Setup dialog 51
Harmonic plug-ins 43
Heal Separation command 14
Help menu
   Pro Tools documentation 75
Hide Others command 1
Hide Pro Tools command 1
Higher QuickTime Playback Priority option 63
Highest QuickTime Playback Priority option 63

I/O Setup dialog 54
Identify Beat command 39
Identify Sync Point command 29
Ignore Track Arming option 69
Import Audio from Current Movie command 9
Import Audio from QuickTime Movie command 9
Import Audio to Region List command 9
Import Audio to Track command 9
Import Avid Video or QuickTime Movie command 9
Import commands 8
Import MIDI to Region List command 9
Import MIDI to Track command 9
Import QuickTime Movie command 9
Import Region Groups command 9
Import Session Data command 8
Infinite Clip preference 60
Infinite Peak Hold preference 60
Input Devices command 57
Input Filter command 56
Input Only Monitoring option 25
Input Quantize command 37
Insert Silence command 13
Insert Time command 32
Instrument plug-ins 43
Invert plug-in 44

L
Latch option 64
Latch Record Enable Buttons option 61
Levels of Undo option 65
LFEs Follow Groups option 66
Limit To option 63
Limiter plug-in 42
Linear Tempo command 33
Link Mix and Edit Group Enables option 61
Link Record and Play Faders option 61
Link Timeline and Edit Selection option 47
Link Track and Edit Selection option 48
Lock/Unlock Region command 27
Loop Playback option 46
Loop Record mode 45
Loop Region command 28
Low Latency Monitoring 49

Machine Chases Memory Location option 69
Machine Control page 53
Machine Control Preferences page 69
Machine Cues Intelligently option 69
Machine Follows Edit Insertion/Scrub option 69
Machine Track Arm Window command 73
Machine Track Arming Profiles dialog 54
Main Counter view options
   Bars:Beats Time Scale 21
   Feet.Frames Time Scale 22
   Minutes:Seconds Time Scale 22
   Samples Time Scale 22
   Time Code Time Scale 22
Make Active Track command 24
Make Inactive Track command 24
Matching Start Time Takes List options 65
Memory Locations Window command 73
Mic Preamps page 53
MIDI Beat Clock command 56
MIDI Controllers page 53
MIDI Controls Transport view option 21
MIDI Event List command 38
MIDI Note Display options 68
MIDI Operation commands 34
   Change Duration 36
   Change Velocity 35
   Flatten Performance 35
   Grid/Groove Quantize 34
   Input Quantize 37
   Insert Time 38
   Operations Window 34
   Restore Performance 35
   Transpose 36
MIDI Operations Window command 34
MIDI Preferences page 68
MIDI Real-Time Properties command 39
MIDI Setup commands
  Input Devices 57
  Input Filter 56
  MIDI Beat Clock 56
  MIDI Studio 56
MIDI Studio command 56
MIDI Thru command 48
MIDI Track Offsets command 38
Minutes:Seconds Time Scale 22
Mirror MIDI Editing option 48
Mix Window command 71
Mix Window follows Bank Selection option 58
Mix Window view options 19
Modulation plug-ins 43
  Chorus 43
  Flanger 43
Momentary Solo Latch option 64
Move Song Start command 32
Movie Track Online command 46
Multi-Tap Delay plug-in 43
Mute Frees Assigned Voice option 48
Mute Record-Armed Tracks While Stopped option 62
Mute/Unmute Region command 27
Mutes Follow Groups option 66

N
Narrow Mix window option 19
New Avid Video Track command 24
New Session command 3
New Track command 23
No Clip indication preference 60
No Peak Hold preference 60
No scrolling option 47
Noise Reduction plug-ins 43
Nondestructive Record mode 45
Normal QuickTime Playback Priority option 63
Normalize plug-in 44
Numeric Keypad Mode 62

O
OMFI 10
Online option 63
Open Ended Record Allocation options 63
Open Media Framework Interchange (OMFI) 10
Open Session command 4
Operation Preferences page 61
Options menu
  Automation Follows Edit option 48
  Auto-Spot Regions option 48
  Calibration Mode 49
  Click command 48
  Delay Compensation option 49
  Destructive Record mode 45
  Link Timeline and Edit Selection option 47
  Link Track and Edit Selection option 48
  Loop Playback option 46
  Loop Record mode 45
  Low Latency Monitoring 49
  MIDI Thru command 48
  Mirror MIDI Editing option 48
  Movie Track Online command 46
  Mute Frees Assigned Voice option 48
  Pre/Post Roll option 46
  Pre-Fader Metering option 48
  QuickPunch mode 45
  QuickTime DV out FireWire command 46
  Scrolling options 47
  Solo Mode options 49
  TrackPunch mode 46
  Transport Online command 46
  Video Track Online command 46
Organize Plug-In Menus By options 59
Other plug-ins 44
  DC Offset Removal 44
  Duplicate 44
  Gain plug-in 44
  Invert plug-in 44
  Normalize plug-in 44
  Reverse plug-in 44
  Signal Generator plug-in 44
  Time Compression/Expansion plug-in 44
P
Page Scrolling option 47
Parabolic Tempo command 33
Paste command 11
Paste Special commands
Merge 12
Overwrite 12
Repeat to Fill 12
Repeat to Fill Selection 12
To Current Automation Type 12
Peak Hold options 60
Pencil Tool Resolution When Drawing Controller
Data option 68
Peripherals dialog 52
Ethernet Controllers page 53
Machine Control page 53
Mic Preamps page 53
MIDI Controllers page 53
Synchronization page 52
PFL (Pre Fader Listen) mode 49
Ping-Pong Delay plug-in 43
Pitch Shift plug-in 42
Play Edit Selection command 13
Play MIDI Notes When Editing option 68
Play Timeline Selection command 13
Playback Engine dialog 52
Playhead 47
Pre Fader Listen mode 49
Pre/Post Roll option 46
Pre-Fader Metering option 48
Preferences command 1
Preferences dialog 58
Pro Tools documentation 75
Pro Tools menu 1
About Pro Tools command 1
Hide Others command 1
Hide Pro Tools command 1
Preferences command 1
Quit Pro Tools command 1
Services command 1
Show All command 1
Processing Preferences page 67
Project browser 72
Project Window command 72
Punch In Frame Offset preference 69
Punch Out Frame Offset preference 69
Q
Quantize to Grid command 29
QuickPunch mode 45
QuickPunch/TrackPunch Crossfade Length option 65
QuickTime DV out FireWire command 46
QuickTime Movie Offset command 54
QuickTime Movie Window command 73
QuickTime Playback Priority option
Higher 63
Highest option 63
Normal 63
QuickTime Playback Priority options 63
Quit Pro Tools command 1
R
Recalculate Waveform Overviews command 81
Recall Memory Location Selection at Original Track
option 64
Recompute Invalid Overviews option 58
Record Online at Insertion/Selection option 63
Record Online at Time Code (or ADAT) Lock option 63
Redo command 11
Region List menu 77
Auto Rename command 79
Clear command 79
Clear Find command 77
Compact command 80
Export Region Definitions command 80
Export Region Groups command 81
Export Regions as Files command 81
Find command 77
Recalculate Waveform Overviews command 81
Rename command 79
Replace Region command 80
Select options 78
Select Parent in Project Browser command 77
Show options 78
Sort By options 79
Time Stamp command 80
Timeline Drop Order command 81
Region List Selection Follows Edit Selection option 65
Region menu 27
- Bring to Front command 27
- Capture command 28
- Group command 28
- Identify Sync Point command 29
- Lock/Unlock command 28
- Loop command 28
- Mute/Unmute command 27
- Quantize to Grid command 29
- Regroup command 28
- Remove Sync Point command 29
- Rename command 28
- Send to Back command 27
- Ungroup All command 28
- Ungroup command 28
- Unloop command 28

Region view options
- Current Time 20
- Name 20
- Original Time Stamp 21
- Overlap 20
- Sync Point 20
- User Time Stamp 21

Regroup Region command 28
Remote Mode option 69
Remove Duplicate Notes command 39
Remove Sync Point command 29
Rename Region command 28
Rename Region List command 79
Renumber Bars command 40
Repeat command 13
Replace Region command 80
Restore Performance command 35
Reverse plug-in 44
Revert to Saved command 5
rulers
  Conductor rulers 20
  Timebase rulers 20
Rulers view options 20

S
- Samples Time Scale 22
- Save As command 4
- Save command 4
- Save Copy in command 4
  Items To Copy 5
  All Audio Files 5

Movie/Video Files 5
- Root Plug-In Settings Folder 5
  Session Plug-In Settings Folder 5

Scale Tempo command 33
Scroll to Track command 26
Scrolling options 47
  After Playback 47
  Center Playhead 47
  Continuous 47
  None 47
  Page 47
S-Curve Tempo command 33
Select All command 13
Select Parent in Project Browser command 77
Select Region List options 78
Selection commands 13
  Change Edit to Match Timeline 13
  Change Timeline to Match Edit 13
  Play Edit 13
  Play Edit Selection 13
  Play Timeline 13
Send Levels Follow Groups option 66
Send Mutes Follow Groups option 66
Send Region to Back command 27
Send via DigiDelivery command 6
Sends A–E view options 21
Sends Default to –INF 61
Sends F–J view options 21
Separate Region commands 14
  At Selection 14
  At Transients 14
  On Grid 14
Separate Region Operates On All Related Takes
  option 65
Services command 1
Session Setup window 55
Set Record Tracks to Auto Input command 25
Set Record Tracks to Input Only command 25
Set Scrub Window Size & Location command 25
Set Servo Lock Bit at Play (Tamura Support)
  preference 69
Setup menu 51
  Click command 57
  Current Feet+Frame Position command 55
  Current Time Code Position command 55
  Disk Allocation dialog 52
  External Time Code Offsets command 55
  Hardware Setup dialog 51
  I/O dialog 54
  Machine Track Arming Profiles dialog 54
  MIDI commands 56
  Peripherals dialog 52
  Playback Engine dialog 52
  Preferences dialog 58
  QuickTime Movie Offset command 54
  Session Setup window 55
Shift command 13
Show All command 1
Show Meters in Sends View option 58
Show Region List options 78
Shuttle Numeric Keypad mode 62
Signal Generator plug-in 44
SIP (Solo In Place) mode 49
Smooth and Thin Data After Pass option 66
Solo In Place mode 49
Solo Latch options 64
Solo Mode options 49
  AFL (After Fader Listen) 49
  PFL (Pre Fader Listen) 49
  SIP (Solo In Place) 49
Solos Follow Groups option 66
Sort By options 79
Split Into Mono Track command 24
Step Input command 38
Stop At Shuttle Speed Zero option 69
Stretch Tempo command 33
Strip Silence command 15
Synchronization page 52
System Usage view options 21
System Usage Window command 74

T
Take Region Lengths That Match option 65
Take Region Names That Match Track Names option 65
Task Manager Window command 71
TC/E Plug-In preference 67

TCE Edit to Timeline Selection command 15
Tempo Operation commands 33
  Constant command 33
  Linear 33
  Operations Window 33
  Parabolic 33
  Scale 33
  S-Curve 33
  Stretch 33
Tempo Operations Window command 33
Thin Automation command 15, 16
Time Code Time Scale 22
Time Compression/Expansion plug-in 15, 44
Time Operation commands 31
  Change Meter 32
  Cut Time 32
  Insert Time 32
  Move Song Start 32
  Operations Window 31
Time Operations Window command 31
Time Stamp Region List command 80
Timebase rulers 20
Timeline Drop Order command 81
Timeline Insertion Follows Playback option 61
Tool Tips Display options 59
Touch Timeout option 66
Track menu
  Auto Input Monitoring option 25
  Avid Video commands 24
  Clear All Clip Indicators command 26
  Delete command 24
  Duplicate command 24
  Group command 23
  Input Only Monitoring option 25
  Make Active command 24
  Make Inactive command 24
  New Track command 23
  Scroll to Track command 26
  Set Record Tracks to Auto Input command 25
  Set Record Tracks to Input Only command 25
  Split Into Mono command 24
  Write MIDI Real-Time Properties command 24
Track Number command 21
Track Position Numbers Stay with Hidden Tracks option 58
TrackPunch mode 46
Transport Numeric Keypad Mode 62
Transport Online command 46
Transport RecordLock option 61
Transport view options 21
Transport Window command 72
Transpose command 36
Trim Region commands 13, 14
End to Fill Selection 14
Start to Fill Selection 14
Start to Insertion 14
To Fill Selection 14
To Selection 14
Trim to All Enabled Automation command 16
Trim to Current Automation command 16

U
Undo Add Avid Video command 24
Undo command 11
Undo History Window command 74
Ungroup All Region command 28
Ungroup Region command 28
Universe Window command 73
Unloop Region command 28
Use All Available Space option 63
Use AudioSuite Dither preference 67
Use F11 for Wait for Note option 61
Use MIDI to Tap Tempo option 68
Use Scrub Window command 25
Use Squeezer option 7

V
Video Track Online command 46
View menu 19
Disk Space view options 21
Edit Window view options 19
Main Counter view options 21
Mix Window view options 19
Region view options 20
Rulers view options 20
Sends A–E view options 21
Sends F–J view options 21
System Usage view options 21
Track Number command 21
Transport view options 21

W
Window menu 71
Automation Enable command 72
Avid Video command 73
Big Counter command 72
Browsers commands 72
Color Palette command 73
Disk Space command 74
Edit command 71
Machine Track Arm command 73
Memory Locations command 73
Mix command 71
Project command 72
QuickTime Movie command 73
System Usage command 74
Task Manager command 71
Transport command 72
Undo History command 74
Universe command 73
Workspace command 71
Workspace browser 71
Workspace Window command 71
Write MIDI Real-Time Properties command 24
Write to All Enabled Automation command 16
Write to Current Automation command 16

X
X–OR (Cancels Previous Solos) Solo Latch option 64